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Introduction

This document explains the XINS functionalities. It starts by explaining how to create and run asimple
API and continue by explaining the more advanced features.

What is XINS?

XINS is an open-source Web Services framework.
XINS supports POX-RPC, SOAP, XML-RPC and more. It consists mainly of an XML -based specification

format and a Java-based implementation framework. From its specifications, XINS can generate HTML,
WSDL, client-side code, server-side code, test forms and more.

Notation

This document uses the Windows file system. If you are installing XINS in a Unix operating system like
Mac OS X, linux or Solaris, change all back slash characters (\') with aforward slash character (/') in the
file names of this document.

The documentation provides some Javadoc links that only work in the HTML generated user guide.

Requirements

XINS requires the following software:

 Java Development Kit 1.4 or higher: http://java.sun.com/javase/downloads/.
If not done by the installation, you should set the environment variable JAVA HOVE to the directory
where you have installed Java. Also add the % AVA_ HOVE% bi n directory to the PATH environment

variable. You can check the Javaversion installed by executingj ava - ver si on.

XINS is adso compatible with Java 1.3.1. If you want to compile your API using Java 1.3.1, proceed
asfollow:

« Download Xalan [http://xml.apache.org/xalan-j/].
e Copy xal an. jar,xerceslnpl.jar andxm -apis.jar to%XI NS_ HOVE% | i b.

e Add-lib %I NS _HOVE% | i b asargument to theant commandslocatedinthebi n\ xi ns. bat
file.

« If youwould liketo usethe HTTPS functionality, then you require al so a JSSE implementation [ http://
java.sun.com/products/jsse/].

XINS has also been tested with Java 5.0 and Java 6.0 .
» Ant: http://ant.apache.org/, version 1.6.2 or higher.
Y ou should set the environment variable ANT _HOVE to the directory where you have installed Ant.

Also add the YANT _HOVE% bi n directory to the PATH environment variable. Y ou can check the Ant
version installed by executingant - ver si on.



http://java.sun.com/javase/downloads/
http://xml.apache.org/xalan-j/
http://xml.apache.org/xalan-j/
http://java.sun.com/products/jsse/
http://java.sun.com/products/jsse/
http://java.sun.com/products/jsse/
http://ant.apache.org/

XINS User Guide

Caution

If youre using the Ant distribution included with Eclipse, you may need to copy
xerceslmpl-2.6.2.jar [http://www.ibiblio.org/maven/xerces/jars/xercesimpl-2.6.2.jar] in the
ecl i pse\ pl ugi ns\ org. apache. ant _1. 6.5\ i b directory. Otherwise you may
have an putDocumentlnCache error message.

If you're using the Ant distribution included with NetBeans and have putDocumentlnCache
error messages, you should change the Ant home location to Ant 1.7.0 or higher (in Tools -
> Options -> Miscalleneous -> Ant.

* Optional: A servlet container. For example: Tomcat [http://tomcat.apache.org/] or Jetty [http://
jetty.mortbay.org/jetty/index.html]. Any J2EE server can also deploy web applications. For
example: Glassfish [https://glassfish.dev.java.net/], Orion [http://www.orionserver.com/], JBoss [ http://
www.jboss.org/], WebSphere [http://www.ibm.com/software/infol/websphere/index.jsp], WebL ogic
[http://www.bea.com/products/webl ogic/server/index.shtml], Resin [http://www.caucho.com/resin/] or
JRun [http://www.macromedia.com/software/jrun/?promoid=home_prod_jr_100803].

For theinstallation of the servlet container, pleaserefer to the documentation of the downloaded product.
XINS containsit's own servlet container implementation for basic testing purposes only.

» Optiona: A version control system. For example CV S[http://www.cvshome.org/] or Subversion [http://
subversion.tigris.org/].

This document will assume that you have installed Java, Ant.

Installation

XINS can be installed using the Windows installer or by downloading the . t gz file and unzipping the
file. Both options are explained below.

Windows Installer

» Download xins-2.1.exe [http://prdownl oads.sourceforge.net/xing/xins-2.1.exe?download] and execute
it. A new directory c: \ Program Fi | es\ xi ns iscreated.

* If you choose to compile and run the demo, you can go to the link provided in the READVE file, then
click on MyFunct i on and on the MyConput er links in the examples section or use the test form
link provided on this page.

Using the .tgz file
» Download XINS 2.1 [http://prdownl oads.sourceforge.net/xins/xins-2.0.tgz?downl oad] .
» Unpack the downloaded file (xi ns- 2. 1. t gz) to adirectory.
 Set the environment variable XI NS_HOVE to the xi ns directory.

» Add the path %XI NS_HOVE% bi n to your PATH environment variable

Note

On Windows, the new environment variable will not be set until you have rebooted or logged
on again. If you don't want to reboot your computer, you can set the variables with set



http://www.ibiblio.org/maven/xerces/jars/xercesImpl-2.6.2.jar
http://www.ibiblio.org/maven/xerces/jars/xercesImpl-2.6.2.jar
http://tomcat.apache.org/
http://tomcat.apache.org/
http://jetty.mortbay.org/jetty/index.html
http://jetty.mortbay.org/jetty/index.html
http://jetty.mortbay.org/jetty/index.html
https://glassfish.dev.java.net/
https://glassfish.dev.java.net/
http://www.orionserver.com/
http://www.orionserver.com/
http://www.jboss.org/
http://www.jboss.org/
http://www.jboss.org/
http://www.ibm.com/software/info1/websphere/index.jsp
http://www.ibm.com/software/info1/websphere/index.jsp
http://www.bea.com/products/weblogic/server/index.shtml
http://www.bea.com/products/weblogic/server/index.shtml
http://www.caucho.com/resin/
http://www.caucho.com/resin/
http://www.macromedia.com/software/jrun/?promoid=home_prod_jr_100803
http://www.macromedia.com/software/jrun/?promoid=home_prod_jr_100803
http://www.cvshome.org/
http://www.cvshome.org/
http://subversion.tigris.org/
http://subversion.tigris.org/
http://subversion.tigris.org/
http://prdownloads.sourceforge.net/xins/xins-2.1.exe?download
http://prdownloads.sourceforge.net/xins/xins-2.1.exe?download
http://prdownloads.sourceforge.net/xins/xins-2.0.tgz?download
http://prdownloads.sourceforge.net/xins/xins-2.0.tgz?download
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XINS HOME=c:\Program Files\xins and set PATH=%PATH% ;% XINS HOME%\bin in
aDOS prompt.

Y ou are now ready to create your first XINS project.

Code conventions

APl names should bein lowercase. E.g. bi | | i ng (andnot Bi | | i ng).

Functions, types and result codes should use the hungarian naming convention and start with an uppercase.
E.g CheckSt at us, Cust orrer and Not Found.

Parameters, functions, types and result codes starting with an underscore ('_") are reserved for XINS.
Parameter names should start with alowercase. E.g: message and houseNunber .

The Java code used for the generated templates and in the examples has private variables starting with
underscore (*_") and contains some comment for the CV S tags. For the rest the Sun Java code conventions
and the Javadoc documentation style rules apply.

Setting up a new project
To create aminimal project with one API containing one function, you need 3 files:
» Xi ns-project.xmn : Thisfile contains the names and properties of the different APIs.
« api . xm : Thisfilecontainsthe declaration of thefunctions, typesand result codes used in your project.

« <functi on nane>. f nc : Thisfile contains the input parameters, the output parameters, the result
codes and some examples of your function.

Xxins-project.xml

 Create anew directory where your APIs based on XINSwill be created. For examplec: \ pr oj ect s.
» Createanew xi ns- proj ect . xm fileinthisdirectory with the content :

<?xm version="1.0" encodi ng="UTF-8""?>
<! DOCTYPE project PUBLIC "-//XINS//DTD XINS Project 2.1//EN'
"http://ww. Xi ns. org/dtd/ xi ns-project_2 1.dtd">
<proj ect name="nyproj ects”
rcsver si on="$Revi si on$" rcsdat e="$Dat e$"
domai n="com nyconpany" >
</ pr oj ect >

api.xml
To createanew api . xim executein the pr oj ect s directory xins create-api.

The command will ask you for the name and the description of your api. The script will then create a new
api . xm fileinthedirectory api s\ <api nanme>\ spec with the content :

<?xm version="1.0" encodi ng="UTF-8""?>
<I DOCTYPE api PUBLIC "-//XINS//DTD XINS APl 2.1//EN'
"http://ww. Xi ns.org/dtd/api _2_1.dtd">

<api nanme="nyproject" rcsversion="$Revi si on$" rcsdate="$Date$">
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<descri pti on>Description of the API.</description>
</ api >

Then the command will ask you if you want to create an implementation of the api. This will create the
skeleton javafilewhere you will write the code of your function. If you answer yes, anew filei npl . xm
iscreated intheapi s\ <api nane>\i npl directory with the content:

<?xm version="1.0" encodi ng="UTF-8"?>
<! DOCTYPE i npl PUBLIC "-//XINS//DTD | npl ement ati on 2.1//EN'
"http://ww. xins.org/dtd/inpl_2 1.dtd">

<i mpl >
</inpl >

Finally the command will ask you if you want to define some environments with your api. If you answer
yes, anew fileenvi ronnent s. xm iscreated intheapi s\ <api nane> directory with the content:

<?xm version="1.0" encodi ng="UTF-8"7?>
<! DOCTYPE environments PUBLIC "-//XI NS//DTD Environnents 2.1//EN'
"http://ww. Xi ns. org/dtd/ environments 2 1.dtd">

<envi ronment s>
<environnent id="local host" url="http://127.0.0.1: 8080/ nyproject/" />

</ envi ronment s>

Note

In this guide we will use the xi ns command to create the different files of the project, but it is
also possible to do it manually using atext editor.

If you created the file manually, add the line <api  name="nyproject"/> in the xi ns-
proj ect. xm file. If the API has an implementation, add the element <i npl / > inthe<api > element
and if it defines some environments add <envi r onnment s/ > in <api >.

MyFunction.fnc

Now that you've created the API definition, we need to define a function within this API.
To create a new function execute xins cr eate-function.

The command will ask you for the name of your api and the name and the description of your function.
The script will then createanew <f unct i on nane>. f nc fileinthedirectory api s/ <api nane>/
spec with the content ;

<?xm version="1.0" encodi ng="UTF-8""?>
<! DOCTYPE function PUBLIC "-//XI NS//DTD Function 2.1//EN'
"http://ww. xi ns.org/dtd/ function_2_1.dtd">
<function nane="MFunction" rcsversion="$Revi sion$" rcsdate="$Dat e$" >

<descri pti on>Description of the function.</description>
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</ function>

If the file was created without calling the creat e-functi on target, add the line <f uncti on
nanme="MyFuncti on"/>intheapi . xm file.

Compiling and running the project

Now we have a simple project with a function that, for the moment, does nothing.

From the specification files XINS can generate :

Soecification documentation.

The specification documentation is a set of static HTML pages containing the description of your
specification. It lists all APIs, functions, types and error codes. The pages a so provide an easy way to
call your function using the web application.

A web application.

The web application is packaged as a WAR file that you can deploy in any servlet container. Once the
WAR fileis deployed, you can access your API through HTTP.

The client-side API.

Theclient APl isaJAR file that can be used to invoke remotely the API functions from Java programs.
It features various advanced features, such as load-balancing, fail-over, extensive logging, etc...

The Javadoc.

The Javadoc contains the definition of the API for the Java classes, including the generated classes. The
javadoc can be generated either for the server side classes or the client side classes.

The HTML specification documentation

To generate the HTML specification documentation (also called specdocs) execute xins specdocs-
mypr oj ect.

Thiswill generate a set of static HTML pages that you can view by opening the filebui | d\ specdocs
\index. htm .

The HTML pages contain:

An overview with a description of the different functions, types and error codes used in your API.

A link for each environment to the meta functions _Get Versi on, _Get Statistics and
_Get Settings.

For each function, adescription of the input parameters, output parameters, the validation rules and the
possible result codes for this function.

For each function, atest form page to test the function.

For each examplein the function, a description of the URL request, the expected result for this example
and the links to execute the example on the given environments.

For each of the types, a description of the type. If the type is an enumeration, the possible values are
written. If the type is a pattern then the regular expression for the pattern is written along with a link
to test the provided pattern.
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The web application.

Create the web application

The web application is packaged asaWAR file. When thisWAR file is deployed on the servlet container,
your functions are accessible through HTTP (for example using Internet Explorer).

To create the web application, execute xins war -mypr oj ect.
This command will createanmypr oj ect . war fileinthedirectory bui | d\ webapps\ nyproj ect\.

This target also generates the skeleton file for the implementation, if the file did not exist.
In our example the file will be api s\ myproj ect\i npl\ com nyconpany\ nyproj ect\ api
\ MyFuncti onl npl . j ava.

You can set some compilation and running properties by creating abui | d. properti es filein your
project directory and set any of the following propertiesin the file:

Table 1. build.properties properties

Property name

Description

Example

build.compiler

The compiler to useto compilethe
classes. (Defaults to javac)

build.compiler=jikes

build.deprecation

Warn if deprecated methods are
used. (Defaults to true)

build.deprecation=false

build.java.version

The version of Java where the
code will be executed.

build.java.version=1.3

org.xins.server.config

The location to the runtime
properties file. Slash and
backslash in the property value
aretrand ated with the system path
separator in XINS. The location
can also beaURL.

org.xins.server.config=../
xins.properties

servlet.port

The port number for the XINS
servlet container (Defaults to
8080).

servlet.port=8181

test.environment

The environment upon which the
tests should be executed (Defaults
http://local host:8080/).

test.environment=http://
i ntegration.mycompany.com/
myproject/

test.start.server

Flag to indicate that the API
should be started when the tests
are executed (Defaults to false).

test.start.server=true

Xerces library that produces
sometimes putDocumentInCache
errors.

wsdl .endpoint The endpoint to use in the wsdl.endpoint=http://
generated WSDL file (Defaults|www.mycompany.com/
to the first entry of the/myproject/
envi ronment . xm file)

reload.stylesheet A work around property for|reload.stylesheet=true
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These properties can also be passed to the system by using - D<property nanme>=<property
val ue> on the command line.

Run the web application
To run the web application, execute xins run-mypr oj ect.

It is adviced to execute the web application with a specified runtime propertiesfile. If no fileis specified,
only the local machine will have access to the API. For more information go to the runtime properties
section.

You can also start the APl using java [-Dorg.xins.server.config=<runtime property file>] -jar
myproject.war [-port=<port number>] [-gui]. It isnot needed to have XINS or Ant installed to run the
API. The requester or the API or the testersfor the API can receive the WAR file and execute it. The -gui
option will start a user interface where the system output will be logged in a console.

To start the WAR fileusing the Jet t y servlet container, create afile named nypr oj ect . xm int the
projects directory with the following content :

<?xm version="1.0" encodi ng="1S0O 8859-1"7?>

<! DOCTYPE Configure PUBLIC
"-//Mrt Bay Consulting//DTD Configure 1.2//EN
"http://jetty.nortbay.org/configure 1 2.dtd">

<Configure class="org.nortbhay.jetty. Server">

<Cal | name="addLi stener">
<Ar g>
<New cl ass="org. nort bay. http. Socket Li st ener" >
<Set nane="port">8080</ Set >
</ New>
</ Arg>
</Call >

<Cal | nane="addWebApplication">

<Ar g>/ nyproj ect/ </ Arg>

<Ar g>bui | d/ webapps/ mypr oj ect/ mypr oj ect . war </ Ar g>
</Call>

</ Confi gure>

Then start java -Dorg.xins.server.config=xins.properties -jar %JETTY_HOME%\start.jar
mypr oject.xml in the pr oj ect s directory.

Now execute your function by going to the address http://localhost:8080/myproject/?
_function=MyFunction.

As nothing isimplemented in your method, your function will just return a successful result.

If you want to get more information on your function or on XINS run the following meta functions:
« http://localhost:8080/myproject/?_function=_GetVersion

* http://localhost:8080/myproject/?_function=_GetStatistics

« http://localhost:8080/myproject/?_function=_GetSettings



http://localhost:8080/myproject/?_function=MyFunction
http://localhost:8080/myproject/?_function=MyFunction
http://localhost:8080/myproject/?_function=_GetVersion
http://localhost:8080/myproject/?_function=_GetStatistics
http://localhost:8080/myproject/?_function=_GetSettings
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Note

If you want to run the example in tomcat, you need to copy the denp\ bui | d\ webapps
\ mypr oj ect\ nyproj ect. war tothet ontat\ webapps directory and then start tomcat
using the startup script. The URLs to access the functions will then start with http://
| ocal host: 8080/ nyproj ect/.

The server-side Javadoc

To generate the Javadoc on the server-side execute xins javadoc-api-mypr oj ect.

Thiswill generate aset of static HTML pages that you can view by opening thefilebui | d\ j avadoc-
api \ nyproj ect\index. htm .

The client API

To generate the jar file for the client API execute xins jar-mypr oj ect.
Thiswill generate ajar filelocated at bui | d\ capi s\ myproj ect-capi .| ar.

The following code shows how to use the generated CAPI to call a function. In this example, the
nypr oj ect API isrunning on the same computer.

i mport org.xins.conmon. servi ce. Tar get Descri ptor;

i mport com myconpany. nmypr oj ect. capi . CAPI ;
i mport com myconpany. mypr oj ect. capi . MyFuncti onResul t;

public class Test MyFunction {
public final static void main(String[] args) throws Exception {

/1l Create the descriptor for the service
Tar get Descri ptor descriptor =
new Tar get Descriptor("http://I ocal host: 8080/ nyproject/", 20000);

/1l Create the CAPI instance
CAPI project = new CAPI (descriptor);

/1 1nvoke the function
MyFuncti onResult result = project.call MyFunction();

/1 No exceptions thown
Systemout.println("Call successful: " + result.getQutputMessage());

}

It's also possible to invoke your APl without using the generated CAPI file but by using the
Xl NSSer vi ceCal | er . Examples on how to do it are provided in the XINSServiceCaller Javadoc
[javadoc/org/xins/client/X INSServiceCaller.html].

The generated cal | MyFunct i on method can throw severa kind of exceptions. For more information,
refer to the generated CAPI Javadoc. Note that a subclass of the exception could be thrown.
For example, if you want to catch the exception only when the function returns an error code,
catch the or g. xi ns. cl i ent. Unsuccessf ul XI NSCal | Except i on which is a subclass of the
org. xi ns.client. Xl NSCal | Excepti on.

10


javadoc/org/xins/client/XINSServiceCaller.html
javadoc/org/xins/client/XINSServiceCaller.html
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You <can aso cach al the exception a once by caching the class
org. xi ns. comon. servi ce. Cal | Excepti on.

try {
/1 1nvoke the function

proj ect.cal |l MyFunction();
} catch (Unsuccessful XI NSCal | Exception ex) {

Systemout.println("A standard error occured: " + ex.getErrorCode());
} catch (Call Exception ex) {
Systemerr.println("Execution failed: " + ex.getMessage());

}

Most of the time your function will have input parameters to pass to the function. This can be done by
passing the parameters to the callMyFunction method:

i mport com myconpany. nmypr oj ect. capi . CAPI ;
i mport com myconpany. nyproj ect. types. Gender;

MyFuncti onResult result = project.call MyFuncti on(Gender. MALE, "Doe");
or to use the generated MyFunctionReguest object:

i mport com myconpany. nmypr oj ect. capi . CAPI ;
i mport com myconpany. nypr oj ect. types. Gender;

MyFuncti onRequest request = new MyFuncti onRequest ();
request . set Gender ( Gender . MALE) ;

request . set Per sonLast Nane( " Doe") ;

MyFunctionResult result = project.call MyFunction(request);

Inthe second case, you don't need to call the set method for the optional parametersthat are not set whereas
in the first case you need to pass null values.

A new packageor g. xi ns. cl i ent . async hasbeen added in XINS 1.4.0. This package providesyou
with some objects which facilitates the call to remote API asynchronously. For more information, read the
article published at http://xins.sourceforge.net/asynchronous.html.

Asof XINS 1.5.0, it isalso possible to call the API without using the HTTP connection but directly as a
function call. You just need to pass the location of the war file containing the API. As no connection is
involved, the time-out represents the total time-out:

Tar get Descri ptor descriptor =
new Tar get Descriptor("file:///honme/ myuser/ nyproject.war", 20000);

The client-side Javadoc

To generate the Javadoc on the client-side execute xins javadoc-capi-mypr oj ect.

Thiswill generate aset of static HTML pages that you can view by opening thefilebui | d\ j avadoc-
capi \ myproj ect\index. htn .

The Open Document Format

The Open Document Format [http://en.wikipedia.org/wiki/OpenDocument] is a standard for word
processors documents (similar to .doc). XINS contains a target that can generate the specifications of an
API in thisformat.
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To create the document, execute xins opendoc-mypr oj ect.
This will generate a bui | d\ opendoc\ nmypr oj ect\ mypr oj ect - specs. odt file than can be

opened with for example Open Office [http://www.openoffice.org/]. Note that Open Officeisfreeand can
save your document as a M S Word document or as PDF.

Implementing the method

For the moment our function has no input, no output and no implementation, we will adapt our previous
project to add a minimum of functionalities.

Defining Input, Output.
Let'sadd to our project three input fields and a result with one output field.
When you are adding input and output parameters to your function, you should at the same time declare
the type of your parameter. There are two kinds of types, the ones already defined in XINS and the ones
you create. The types already defined in XINS are explained in the next chapter.

To create anew type for your project execute xins create-type.

The command will ask you for the name of the API, the name of the type and the description of the type.
It will then create anew <t ype nane>. t yp file with the content :

<?xm version="1.0" encodi ng="UTF-8""?>
<! DOCTYPE type PUBLIC "-//XINS//DTD Type 2.1//EN'
"http://ww. Xi ns.org/dtd/type 2 1.dtd">

<type nane="TypeNane"
rcsver si on="$Revi si on$" rcsdat e="$Dat e$" >

<descri pti on>Description of the type.</description>
</type>
The different possibilities of types that could be defined are listed in the section called “ Defined types’.
Let's create two types for our project, one with the typel ast Nane and one with the type gender .
Edit the Last Nane. t yp filewith

<descri pti on>Last name of a person. </description>
<pattern>[ A-Za-z ]{1,50}</pattern>

Edit the Gender . t yp with

<descri pti on>A gender. </ descri pti on>

<enune
<i tem nanme="mal e" val ue="nt" />
<item name="femal e" val ue="f" />
</ enune

If the name attribute is not specified it will be the same as the value attribute.
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Now that the types are created, we need to add the declaration in api . xnl and to set them as input
parameters in our function. For the output we will use a predefined type so there is no need to define the
typeinapi . xm .

Add <t ype nane="CGender"/>and<type nanme="Last Nanme"/>toapi.xnl .
Add tothefile MyFuncti on. f nc :

<i nput >
<par am nane="gender" required="true" type="Gender">
<descri pti on>The gender of the person. </description>
</ par anp
<par am nane="per sonLast Nane" required="true" type="Last Nane">
<descri ption>The | ast name of the person. </description>
</ par anp
</i nput >
<out put >
<par am nane="nessage" required="true" type="_text">
<descri pti on>The nmessage returned to this person. </description>
</ par anp
</ out put >

Y ou can aso assign adefault value for an optional parameter using thedef aul t attribute.
<par am nane="gender" required="fal se" type="Gender" default="ni>

<descri pti on>The gender of the person. </description>
</ par anp

Defining the test environments.

Y ou can specify in XINS the environments where you want to test the API.

As seen in the section called “api.xml”, it's possible create the file containing the test environments by
using the xins create-api or by creating the filewith atext editor and editing the xi ns- pr oj ect . xmi .

When you generate the specification documentation, for each function defined in the API alink below
"Test forms" that points you to a HTML form which is used to fill the input parameters of the function.
When you then click on Submit the function will be executed on the specified environment. Thisrequires
of course that the application isinstalled on the defined environment.

The environments are aso listed on the main page of the specification documentation along with some
links that provide direct access to some meta functions.

If you want to add a new environment, just add for example <envi r onnent i d="pr oducti on"
url ="http://ww. myconpany. com 8080/ ny-proj ect/" />toenvironnents. xnl.

Defining the examples.

Y ou can also define some examples for your APl in the specification. The definition of the examples are
done in the function specification file.

Let's add some examplesto MyFunct i on. f nc by adding the following text after the out put section:

<exanpl e resul tcode="_I nval i dRequest " >
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<descri pti on>M ssi ng paraneter : | astNanme</description>

<i nput - exanpl e nane="gender " >nx/i nput - exanpl e>
</ exampl e>
<exanpl e resul tcode="_I nval i dRequest " >

<descri pti on>l nval i d paraneter</description>

<i nput - exanpl e nane="gender " >nx/i nput - exanpl e>

<i nput - exanpl e nane="per sonLast Nane">Bond 007</i nput - exanpl e>
</ exampl e>
<exanpl e>

<descri pti on>Message returned. </ descri ption>

<i nput - exanpl e nane="gender " >f </ i nput - exanpl e>

<i nput - exanpl e nanme="per sonLast Nane" >Lee</i nput - exanpl e>

<out put - exanpl e nane="nessage">Hel |l o M ss Lee</ out put - exanpl e>
</ exampl e>

This example shows how to add some examples to a function with i nput and out put parameters but
it's also possible to define examples for a function that contains a data section or returns a result code
that contains some parameters. For more information, look at the function specification defined in the
al | i none project.

The examples are shown on the generated specification documentation and if you have also defined some
environments, you can execute the example by just clicking the provided links.

In XINS 1.4.0, you can create an example using xins create-example. The APl should be running on

http://local host:8080/<api name>/. The create-exampletarget will ask you for the name of the APl and the
request URL. The example is automatically added to the function.

Implementing your function.

You can edit the new MyFuncti onl npl . j ava generated file located in the api s\ nypr oj ect
\'i mpl \ com nyconpany\ mypr oj ect\ api directory with

public final Result call (Request request) throws Throwabl e {

String nom nation = null;
i f (request. getGender().equal s(com myconpany. myproj ect.types. Gender. MALE)) {

nomi nation = "M ster";
} else {
nomi nation = "M ss";
}
Successful Result result = new Successful Result();
result.set Message("Hello " + nomination + " " +request. get PersonLast Nane());

return result;

}
Executing your function

We first need to rebuild the WAR file, the spec docs, the client jar and the javadoc by executing xins all-
mypr oj ect.

Now you must restart the servlet container server and reopenthefilebui | d\ specdocs\i ndex. ht i .
You can test your function by either clicking on the link provided with the examples or by using the test
forms.
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The error code

An error code (previously named result code) contains the description of an error that occurred when
executing the implementation code.

When you generate the specification documentation, you can already notice that some error codes aready
exist by default. These error codes are returned by the system when the problem occurs.

Y ou should create custom error codes whenever the implementation of your function would encounter an
error condition that should be distinguishablefor the caller. For example, if you connect to another service,
if you perform I/O operations or if the input fields should match fields in a database.

We will now extend our example with a NoVowel error code. Note that this error could be also detected
by improving the |l ast Namne pattern.

Create a error code by executing xins create-rcd.

The command will ask you for the name of your api and the name and the description of your error code.
The script will then create a new NoVowel . r cd file in the directory <specsdi r >/ <api nane>
with the content :

<?xm version="1.0" encodi ng="UTF-8""?>
<! DOCTYPE resultcode PUBLIC "-//XI NS//DTD Result Code 2.1//EN'
"http://ww. xXi ns.org/dtd/ resul tcode_2_ 1.dtd">

<resul t code nane="NoVowel "
rcsver si on="$Revi si on$" rcsdat e="$Dat e$" >

<descri pti on>The name does not contain any vowel s. </ description>

</resul tcode>

Once thisfile is created, add the line <r esul t code nanme="NoVowel " /> intheapi . xm file
A reference to this error code also needs to be defined in the function that may return this error code. In
our case MyFuncti on. f nc. Also add theline<r esul t code-ref nanme="NoVowel " /> atthe
beginning of the out put section of MyFunct i on. f nc.

Now we need to adapt our Java codeto detect if the given last name does not include any vowelsand return
the error code when it isthe case. Add the following code at the beginning of your cal | () method.

String | ast NanmeLower = request. get PersonLast Nane().tolLower Case();

if (lastNaneLower.indexOr('a') == -1 && | ast NaneLower.indexOf('e') == -1 &&
| ast NanmeLower.indexOf ("i') == -1 && | ast NameLower.indexOf('0') == -1 &&
| ast NanmeLower . i ndexOf ("u') == -1 && | ast NaneLower.indexOr('y') == -1) {

return new NoVowel Result ();

}

Now we need to adapt the specification of your function to include this result code in the examples. We
moved the example 3 to example 4 as we wanted to keep the order "unsuccessful results’ "successful
results" in our examples and we added the example 3 with

<exanpl e resul t code="NoVowel| ">
<descri pti on>The name does not contain any vowels. </ description>
<i nput - exanpl e nane="gender " >f </ i nput - exanpl e>
<i nput - exanpl e nane="per sonLast Nane" >qgsl kfj </ i nput - exanpl e>

</ exampl e>
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You can now regenerate everything with xins all-myproject and after restarting the servlet container
server, test the new example using the generated specification documentation.

Since XINS 1.4.0, it is possible to specify if an error code is functional or technical. Functional error code
are error that may occur such as| nval i dPasswor d where as technical errorsindicate a problem such
asDat abaseCor r upt ed. By default an error code istechnical. To specify the error code as functional
add the attributet ype="f unct i onal " tother esul t code element.

If you want to reuse an error code aready defined in another API, you don't need to copy thefile. You can
also point to the error code of the API. Its uses the same system as in the section called “ Shared types’.

The runtime properties

You may want to add some flexibility to your application by changing a property without needing to
recompile the code or restarting the server. This way you can distribute the same WAR file of your web
application to different places. Y ou can think at the following situations:

A filelocation may differ on the computers on which you want to deploy your application.

» Thelocation of adatabase may differ depending on whether you want to test your application or deploy
it in a production environment.

A username/password which you don't know the value and should be entered by the administrator.

A link to another XINS service, in case of adistributed environment.

Y ou would like to adjust settings that influence performances.

Y ou would like to adjust the debugging level.

The properties for your APIs are defined in the runtime properties file often named
Xi ns. properti es. This file location is passed to the application server with the system property
org. xi ns. server.config.

To dart the WAR file using the XINS servlet container, just execute xins -
Dorg.xins.server .config=xins.properties run-myproject. You can aso set the location of the
xins. propertiesinthebuil d. properti es and then execute xinsrun-mypr oject.

Note

If you want to run the example in tomcat, you need to add in the file t ontat\ conf
\catal i na. properties the line org.xins.server.config=c:\\Program
Fi | es\\ xi ns\\denp\\xi ns. properties.

Example of runtime propertiesfile:

#

# Ceneral XINS properties

# Check configuration file every 60 seconds
org. xi ns. server.config.rel oad=60

# Access rul es
org. xi ns.server.acl =all ow 127.0.0. 1 *;

# Loggi ng properties
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org. xi ns. | ogdoc. | ocal e=en_US

An exampleisaso provided inthe deno\ xi ns. properti es file.

The properties

Some properties defined in thisfile are already interpreted by the system:

Table 2. xins.propertiesruntime properties

Property name

Required

Description

Example

org.xins.server.config.rel

pad, defaults to 60.

Interval in seconds for
check the xins.properties
file for any changes.

org.xins.server.config.rel

had=60

org.xins.server.acl

no, defaults to localhost.

Access rules for the

functions

org.xins.server.acl=allow
127.0.0.1 *; \
alow  192.168.0.0/24
MyFunction

org.xins.server.acl.<api
name>

no

Access rules for the
functions of the specified
API. The specified rules
are executed before the
generic one.

org.xins.server.acl.mypro|
127.0.0.1 * \
deny 192.168.0.0/24
MyFunction

ect=allow

org.xins.server.config.inc

onde

A comma separated list
of runtime property files
to include. The files
should use relative paths.

org.xins.server.config.ing
default-xins.properties

ude=../

org.xins.logdoc.locale

no, defaultsto en_US.

The locale to be used for
the logging messages.

org.xins.logdoc.locale=en |

us

org.xins.server.jmx

no, false by default.

Enables the management
of the APl using
IJMX (Java Management
eXtension).

org.xins.server.jmx=true

org.xins.server.contextlD

fittesl| typesof context ID
are accepted by default.

The regular expression
pattern for the expected
format of the context
ID. If the context ID is
invalid, anew onewill be
generated.

org.xins.server.contextl D
ZA-Z]{5}

filter=[a-

org.xins.|ogdoc.stackTrag

ediM eefagitseved false
meaning that the stack
traces are logged at
DEBUG level.

Flag indicating that the
exception stack trace
should be logged at
the same level as the

message.

org.xins.logdoc.stackTrad

eAtMessagel evel

logdj.*

no, defaults to console.

Logging properties used
to adapt the debug level,
formatting or output to
your needs.

log4j.rootLogger=DEBU
console

o

log4).<api

no, defaults to

name>.rootL ogger

log4j.rootLogger.

Root logger for the

specified API.

log4j.myproject.rootLogg

er=INFO,

logfile_myproject
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Getting properties value

Now we will adapt the xi ns. properties for the MyFuncti on implementation by adding the
following lines:;

# Sal utation nessage for the person
salutation=Hel |l o

We now need to change the implementation to read and use the property. Note that the property should be
able to be changed at runtime. Add the following codeto MyFunct i onl npl . j ava

i mport org.xins.conmon. col | ections. M ssi ngRequi redPropertyException;
i mport org.xins.conmon. col | ections.|nvalidPropertyVal ueExcepti on;

i mport org.xins.conmon. col | ections. PropertyReader;

i mport org.xi ns. conmon. nanageabl e. Boot st r apExcept i on;

i mport org.xins.conmon. manageabl e. I nitializati onException;

/**
* The sal utation nessage.
*/

private String _salutation;

protected void initlnpl(PropertyReader properties)
t hrows M ssi ngRequi redPropertyExcepti on,

I nval i dPr opert yVal ueExcepti on,

Initializati onException {

/1 CGet the salutation

_salutation = properties.get("salutation");

if (_salutation == null || _salutation.trin().equals("")) {
t hr ow new M ssi ngRequi r edPr opertyException("sal utation");

}

/1 Here you can al so chack the value and throw an
/1 1nvalidPropertyVal ueException if needed

}

public final Result call (Request request) throws Throwabl e {

result. set Message(_salutation + + nom nation + " " +
request . get Per sonLast Nane());

return result;

}

Now recompile your code, restart the server, execute the function, change the vaue in
Xi ns. properti es toHi,wait for the server to rel oad the propertiesfile and execute the function again.

The API class defines adei ni t | mpl () method. This method is used to release resources when you
stop the API.

Note

When the xins.properties file has changed, only the i ni t I npl () method is invoked. The
dei ni t I npl () iscaled only when you stop the servlet container.
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The API class has a boot st rapl npl 2( Propert yReader buil dSettings) method that is
called the API is started. The buil dSettings passed as parameters are the properties stored in theweb. xm
fileincluded in the deployment war file.

The APl class has a reinitializelnpl () method. This method can be invoked in your
implementation to ask the framework to reinitialize the API.

Defining properties

XINS 1.3.0 includes a new system that allows to define runtime properties that you will use in your
APl inthei npl . xm file. In this file you define the name of the property, its description, its type and
whether is property is required or optional. The value of the property still needs to be defined in the
Xins. properti es file

Example:

<i npl >
<runti me-properti es>

<property nane="nyproject.eurodollar.rate" type="_float32" required="true">

<description>The price in dollars of 1 euro.</description>
</ property>
</runtine-properties>
</inmpl>

Now when the specification documentation is generated, a new page is available containing the list of the
runtimes properties used by the APl along with their description, their type and whether the property is
required or optional. This page makes it easier to deploy an API with the correct runtime properties set.

Another advantage of defining the propertiesthisway isthat you don't need to implement thei ni t | npl
method to retreive the property values. A classis generated that checks and retreives the properties. If the
value of a property isincorrect or arequired property is missing then the API will fail with a description
of the problem. Theget API () . get Properti es() method can aso be called from thei ni t | npl
method of your function, if you want for example initialize another object based on aruntime property.

Example on how to use the generated class:

/1 No inmports needed, no initlnpl nethod needed

public final Result call (Request request) throws Throwabl e {
Successful Result result = new Successful Result();
result.setPricelnEuro(request.getPricelnbDollar() /

((RuntinmeProperties) getAPI().getProperties()).getMprojectEurodoll arRate

return result;

}

If the property was optional, aj ava. | ang. Fl oat object would have been returned.

The bootstrap properties

The bootstrap properties are the properties defined in the generated web. xnl file. These properties
cannot be modified at runtime. You can view the properties by calling the calling the meta function
_Get Set ti ngs. Whenthe WAR fileis created XINS set some default properties which are:

org.xins.api.name The name of the API.
org.xins.api.build.version The version of XINS with which the WAR file was
created.
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org.xins.api.version The version of the APl (may be empty).
org.xins.api.build.time The time at which the WAR file was created.
org.xins.api.calling.convention The name of the default calling convention.

Y ou can also define your own properties. Just add <boot st r ap- properti es>and <boot st r ap-
property> elementstothei nmpl . xm file.

Example:

<i npl >
<boot strap-properti es>
<boot strap-property nane="xi ff.| ogi n. page" >Logi n</ boot strap- property>
<boot strap-property nane="xi ff.defaul t.conmand" >Def aul t Command</ boot st r ap- pr op
</ boot st rap- properti es>
</inpl>

Note

Bootstrap properties starting with org.xins. are reserved except for the
org. xi ns. server. confi g bootstrap property. This property could be set to indicate the
location of the runtime properties file in the case that you cannot passit in the command line of
the Servlet container.

The values of the properties will be available in the boot strapl nmpl ( PropertyReader
boot st rapPr operti es) method of your functions and shared instances.

Integration with CVS

As you've probably already noticed al of our specification files have r csver si on="$Revi si on
$" andr csdat e="$Dat e$" when the files are stored in a control version system such as CVS, the
$Revi si on$ is replaced by something like $Revi si on 1.2 $ and $Dat e$ with something like
$Dat e 2006/ 11/13 15:16:47 $. Thisis particularly useful when you want to keep track of the
version and the date of the last changes of the specification.

XINS allows you also to freeze the different parts of the specification. This is particularly useful if the
person or department using the APl is not the same as the one designing it or implementing the API.
This way the different parties can assume the required input or output parameters. If for some reasons a
function or a type changes, the specification documentation would mark the function or type in red with
atag "broken freeze".

To freeze a function, a type or a result code add the attribute freeze next to the name in api . xmi . The
value of this attribute should be the version of the frozen specification.

For example
<api nanme="nyproject" owner="johnd"

rcsversi on="$Revi si on: 1.3%" rcsdate="$Date: 2007/09/04 15:18:07 $">
<function nane="M/Function" freeze="1.3" />

<type nanme="Gender" freeze="1.1" />
<type name="Last Name" />

<resul tcode nane="NoVowel " freeze="1.2" />
</ api >
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Y ou can also specify inthe xi ns- pr oj ect s. xm theroot of the cvsweb location;
<cvsweb href="http://cvs. nyconpany. com cvsweb/ nyproj ects" />

If this element is provided, broken freeze will provide you with a link where you will be able to see the
changes done for thisitem since it has been frozen. If you use vi ewcvs only the first provided link will
work.

Managing dependencies

For advanced APIs, you would probably need to use some external libraries or to use other services. This
can be done by adding dependencies to your API.

InXi ns- proj ects. xm youcanadd an attributedependenci esdi r toindicateinwhich directory
the jar files used by your project will be included. For example

<proj ect name="nyproj ects"
rcsver si on="$Revi si on$" rcsdat e="$Dat e$"
dependenci esdi r="../ ot her-projects"
domai n="com nyconpany" >

</ proj ect >

Inapi s\ <api >\i npl \'i npl . xm you add the jar files needed for your project using the dependency
element. For example

<i npl >

<dependency dir="utils" />

<dependency dir="capis" includes="project2-capi.jar" />
</inpl>

In the previous example when your implementation will be compiled the following jar fileswill bein the
classpath: . . \ ot her-projects\utils\*.jar;..\other-projects\capis\project2-
capi.jar;..\other-projects\xins\xins-client.jar.These fileswill also be included
in the generated WAR file.

An example of dependenciesis provided in XINS with thefi | t er edpr oj ect demo. This APl cals
another API (myproject) using CAPI.

Note

The order of the elementsin theimp.xml isimportant, if the elements are not in the correct order
the validation of i npl . xm with the DTD will fail.

The order is | ogdoc, boot strap- properti es, runti ne-properties,
content, dependency, calling-convention, instance.

Adding other files to the WAR file

It is possible to add any kind of files to the WAR file. Thisis particulary useful if you want to deploy a
web site at the same time as your API.

Todoit add content elements to the impl.xml file. Note that you'll need to also add aweb- pat h attribute
to the impl element because the API is by default mapped with the root path. So in order to accessthe file
you have added to the WAR file, you will need to associate the APl with another path.

Example:
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<i mpl web- pat h="store">
<content dir="apis/petstore" includes="xslt/*.xslt" />
<content dir="apis/petstore/web" includes="*.htm *.js" />
<content dir="apis/petstore/web" includes="*.jpg" web-path="imges" />

</inmpl>
Note

If you only want to add files to the VEB- | NF directory, for example to use them in your API,
then you don't need to specify theweb- pat h attribute to thei npl element.

Multiple implementations and stubs

XINS can support multiple implementations for the same API. To add a new implementation for the AP
addinthexi ns-proj ects. xm ani npl element with anane attribute to the api. For example

<proj ect name="nyproj ects"
domai n="com nyconpany" >
<api nane="al linone">

<inmpl />
<i npl name="nmnystub" />
</ api >

</ proj ect >

New targets are created for this implementation. Only server side targets (war, javadoc-api, run, ...) are
created for this new implementation. The other targets only depend on the specification which doesn't
change. The new target syntax is <acti on>-<api nane>-<i npl enentati on nane>. For
exampl e to compile the new implementation of the exampl e above execute xins classes-allinone-mystub.

Note

Thelist of the API names with the possible implementation is printed at the end of the execution
of the xins help command.

Having the possibility to have more than one implementation is useful when you want to create a stub
(fake API) so that other systems can test the API before being implemented.

XINS offers the possibility to generate a stub implementation of the API. The stub is generated based on
the examples defined in the function specification.

To generate the stub implementation execute xins stub-<api name>-<implementation name>. Then the
stub file are generated in the directory api s\ <api nane>\i npl - <i npl enment ati on nane>
\ <package nane>. You can also edit the generated code, for example to be more flexible with some
input parameters or to return other values. Note that the stub target won't replace existing files.

Testing

XINS offers different waysto test your API.

The first way is using the generated test forms or the links provided with the examples on the function
page of the generated specdocs.

XINS offers also the possibility to test the API using the JUnit library. XINS will generate the unit test
based on the examples defined in the functions specification. To be ableto test your API proceed asfollow:
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 Addat est elementtotheapi elementinthexi ns-proj ects. xm . For example:

<proj ect nanme="nyproj ects"
domai n="com nyconpany" >
<api nane="al |l i none">

<impl />
<test />
</ api >

</ pr oj ect >
* Runthe API. For example: xinsrun-allinone.
» Execute the test target. For example: xins test-allinone.

The test target will generate the unit tests in the directory api s\ <api nane>\t est\ <package
nane>. Themain test case executed iISAPI Test s. j ava whichincludesthefunction tests. One example
matches one test.

The generated unit tests are editable. Y ou can adapt it to better fit the expected result or to add your own
unit tests. Note that the test target won't overwrite filesif thet est directory already exists.

The result of the unit tests is located in the directory bui | d\t est resul t s. Results are provided
in XML and HTML. The XML contains the configuration settings and the logs generated. The HTML
contains the results of the test in a more human readable format.

To beablefor the test target to work correctly, you haveto copy thej uni t . j ar filelocatedinxinsl i b
directory tothel i b directory of ant.

The test target also have an option to run the APl before starting the tests. To use it, add
test.start.server=true tothebuil d. properties. If this option is set, you don't need to
execute the xins run-<api name> command.

If you want to execute the tests on another environment than you local machin, you can specify it in the
bui | d. properti es by setting the propertiest est . envi ronnent .

Note

The <t est /> element should be added after the <i npl /> and <envi ronnents />
elementsif defined.

Categories

Sometimes an API can contains a lot of functions. It become then more difficult to find the function in
the specdocs. XINS 1.3.0 introduced the notion of categories. With categories you can specify functions
that belong together.

Example:
Define the category names at then end of api . xm :

<api nane="al linone">

<cat egory nane="Dat aSections" />
</ api >

Then create a category file with the name <cat egory nane>. cat . Thisfile will define the function
that are in the same group.
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Example Dat aSect i ons. cat :

<?xm version="1.0" encodi ng="US- ASCl | " ?>
<I DOCTYPE cat egory PUBLIC "-//XINS//DTD Category 1.3//EN' "http://ww.Xi ns.org/dtd
<cat egory nane="Dat aSecti ons" >
<descri ption>Data section related functions. </description>
<function-ref name="DataSection" />
<function-ref name="DataSection2" />
<function-ref name="DataSection3" />
</ cat egory>

Now if you regenerate the specdocs, The categories will appear at the top of the API page. Y ou can then
more easily find the function you wanted.

Managing logs
XINS includesit's own logging system called logdoc which is based on log4;.

Managing the logs on the server side.

Y ou can also manage the debugging settings of XINS by changing the xins.properties file. Here are the
main logging settings that can be changed:

Table 3. Log4j properties

Property Value examples Description

log4j.rootLogger DEBUG, console, logfile Indicates the level of logging and
the modules that will receive the
output.

log4j .<api name>.rootL ogger INFO, logfile2 Indicates the level of logging and

the modules that will receive the
output for the specified API.

|og4j.appender.console org.apache.logdj.ConsoleAppenderndicates where the output is
redirected for the module.

log4j.appender.consol e.layout org.apache.logdj.PatternLayout | Indicatesthe pattern for the output
header (text that precedes the

output text).
l0g4j .appender.consol e.layout. Condedborbiatiec/ox - %om%n Indicates the format of the output
header.
log4j.1ogger.org.xins.common.expiBRRAR Changes the log level for a

message. This can be useful if you
want to hide a message or if you
want to show a message.

Thelog levelsare DEBUG< | NFO< NOTI CE < WARN < ERROR < FATAL. Thismeansthat if you set the
log level to ERROR, only the ERROR and FATAL messages will be logged.

For more information on the possible characters in the conversion pattern, visit the log4j website [http://
logging.apache.org/logdj/docs/api/org/apache/l ogdj/PatternL ayout.html].

The nested diagnostic context (NDC - %x) is set to the value of the _cont ext parameter of the query. If
no_cont ext parameter ispassed adefault contextiscreated asapi Nane@ ocal Host : yyyyvvid-
HHmMssNNN: r andomwhere;
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» apiNameisthe name of the API.
* localHost isthe IP address of the computer that is running the api.

* yyyyMMdd-HHmmssNNN is the date of the request (year - month - day - hour - minute - second -
millisecond).

 random isab digits long random hexadecimal generated number.

For moreinformation on the possiblelogging properties and values, visit logdj documentation page [http:/
logging.apache.org/logdj/docs/manual .html].

Adding your own logs.

It's sometimes useful to log events that may happen in your function. To do so, you need to create what
is called alogdoc (log documentation).

To create anew logdoc execute xins create-logdoc.

The command will ask you for the name of your api. The script will then create anew | og. xn filein
the directory api s\ <api nane>\i npl with the content:

<?xm version="1.0" encodi ng="UTF-8""?>
<I DCCTYPE | og PUBLIC "-//XINS//DTD XINS Logdoc 2.1//EN'
"http://ww. xi ns.org/dtd/log_2_1.dtd">

<l og>
<transl ati on-bundl e | ocal e="en_US" />

<group id="exanpl ei d* name="Exanpl e">
<entry id="10000" | evel =" DEBUG' >
<descri pti on>Exanpl e of | ogdoc with sone paraneters. </description>
<par am nane="paraneter" />
<par am nane="nunber" nul | abl e="fal se" type="int32" />
</entry>
<entry id="10001" | evel ="ERROR' exception="true">
<descri pti on>Exanpl e with an exception. </ descri ption>
</entry>
</ group>
</l og>

The  group id is used for the  creation of the log key (ed.
com nyconpany. nyproj ect. api . exanpl ei d. 10001) and the group name is used for the
description of the group.

It also creates adefault trandation filet r ansl at i on- bundl e- en_US. xn with the content:

<?xm version="1.0" encodi ng="UTF-8""?>
<I DOCTYPE transl ati on-bundl e PUBLIC "-//XINS//DTD XINS Transl ati on Bundle 2.1//EN'
"http://ww. Xi ns. org/dtd/transl ation-bundle_2_1.dtd">

<transl ati on- bundl e>
<transl ati on entry="10000">Exanpl e of |ogdoc with the paraneter <val ue-of-param
<transl ati on entry="10001">Exanpl e of an exception.</transl ati on>

</transl ati on-bundl e>
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You can now use the logdoc in your function implementation by caling the method
Log. | og_10000( myParam 36);

The command will also add the element <| ogdoc / >totheimpl element of thei npl . xm file. If you
want to use thelogsin packages other than the default one add the attributeaccessl evel =" publ i c"
tothel ogdoc element.

The Logdoc consist of amain | og. xm file which defines the possible locale for the logs of this API
and the groups of entries. Each entry has an i d that is by convension a number higher than 10000 as
numbers between 1000 and 9999 are reserved for XINS. Ids don't have to be consecutive humbers. It's
even advisable to have numbers gaps between groups.

If the entry has the attribute excepti on with the value t r ue, then the exception should be
the first parameter when invoking the method. For example the id 10001 should be invoked with
Log. | og_10001( myException);.

The possible types for a parameter are bool ean, i nt 8,i nt 16,i n32,i nt 64, t ext and obj ect .
By default for a parameter the nullable attributeis set to t r ue and the type attributeissettot ext .

These types match respectively in Java the types bool ean, byt e, short,int,l ong, Stri ng and
hj ect .

If you use logdoc in your API, the list and the description of the defined log entries will be available in
the specification documentation.

Inthel og. xm thewarning level isset with| evel =" WARNI NG' but thelevel istranslated asthe WARN
log4j level.

Note that when the specification documentation (specdocs) is generated the HTML pages describing
the logging message is also generated. You can see the XINS logdoc at http://xins.sourceforge.net/
logdoc.html.

Configuring the properties files for specific logs

Sometimestoo much loginformationis printed and you would like to remove some of the messages printed
by the log.

There are several waysto do this. The best ways isto hide the logging messages you don't want.
The following example will hidethe HTTPCl i ent DEBUGIogs:

| og4j .1 ogger . org. apache. commons. htt pcl i ent =I NFO
| og4j .1 ogger. httpclient=lINFO

The following example will hide all XINS messages which are not at least at the WARN level:

| og4j . 1 ogger. or g. xi ns=\ARN

The following example will hide the specific logging message because the message is at DEBUG level:
| og4j .1 ogger.org. xins.server.lifespan.init.3402=1 NFO

Thelocale can also be specified in the XINS propertiesfile:

# Local e used for | ogging
org. xi ns.server. | og. | ocal e=en_US

Thelogdoc with thelocaleen_US and f r _FRare provided in XINS.
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An example of a XINS properties file with a customized logging system can be found in the deno
directory.

Managing load balancing and fail over

XINS can aso manage load balancing and fail over when you want to invoke your function using CAPI.
To do so, your function needs to be started on 2 computers. Our code is based on the CAPI example done
in the section called “The client API”.

The first possibility would be to use the G- oupDescri pt or (javadoc [javadoc/org/xins/common/
service/GroupDescriptor.html]) instead combined with a Tar get Descr i pt or (javadoc [javadoc/org/
Xing/common/service/ TargetDescriptor.htmi]):

/1l Create the descriptor for the service

Target Descri ptor serverl = new TargetDescriptor("http://192.168.0.20: 8080/ ny-proj e
Tar get Descri ptor server2 = new TargetDescriptor("http://192.168.0.21: 8080/ ny-proje

Descriptor[] servers = {serverl, server2},

/1 Create the descriptor for |oad bal ancing

GroupDescri ptor descriptor = new G oupDescriptor (G oupDescri pt or. RANDOM TYPE, serv

/* If you wanted to have fail over replace the above line with

GroupDescri ptor descriptor = new G oupDescri ptor (G oupDescri ptor. ORDERED TYPE,

The drawback of this method is that it's not flexible, any changes of | P addresses, time-out or if you want
to add a new server, you would need to adapt the code, recompile and then redeploy it.

A better method would be to have the URL s and the time-out in a property file. The only code you need
then to create your descriptor is

/1 Build the descriptor

Descri ptor descriptor = DescriptorBuil der.build(properties, "capis.nyproject");

where propertiesisthe Pr oper t yReader object that contains your parameters.

If you only have one server (for example your computer for testing), set the properties as

capi s. nmyproj ect=service, http://127.0.0.1:8080/ nmy-project/, 20000
If you want to have load balancing, set the properties as

capi s. myproj ect =group, random serverl, server2
capi s. myproj ect.serverl=service, http://192.168. 0. 20: 8080/ ny- proj ect/,
capi s. myproj ect.server2=service, http://192.168.0.21: 8080/ ny- proj ect/,

If you want to have fail over, set the properties as

capi s. nyproj ect =group, ordered, serverl, server2
capi s. nyproj ect. serverl=service, http://192.168.0.20: 8080/ ny- proj ect/,
capi s. nyproj ect. server2=service, http://192.168.0.21: 8080/ ny- proj ect/,

It's possible to combine load balancing and fail over. For example in the following code the invocation is
balanced between serverl and server2 and if one of both is down back-up will be used.

capi s. myproj ect =group, random systeml, systen?
capi s. myproj ect.systeml=group, ordered, serverl, back-up
capi s. myproj ect.systenR=group, ordered, server2, back-up
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capi s. myproj ect.serverl=service, http://192.168. 0. 20: 8080/ ny- proj ect/, 20000
capi s. myproj ect.server2=service, http://192.168.0.21: 8080/ ny-project/, 20000
capi s. myproj ect. back-up=service, http://192.168. 0. 22: 8080/ ny- proj ect/, 20000

Thefail-over isnot always executed when an error occur, the condition upon which thefail-over isexecuted
arelisted in the XINSServiceCaller Javadoc [javadoc/org/xing/client/XINSServiceCaller.html].

XINS types

the section called “ Defining Input, Output.” shows you an example on how to use the types when defining
the function.

Predefined types.

XINS has some integrated types which facilitate the use of input and output parameters with the
implementation.

Table4. XINSintegrated types

type Java representation Example

_text javalang.String hello world

_boolean boolean true

_int8 byte 25

_int16 short 2004

_int32 int 15

_int64 long 654654132135544566

_float32 float 25.6

_float64 double 3.14159

_date org.xins.common.types.standard. DaROdeh 1<

_timestamp org.xins.common.types.standard. Ti208te61z1 VEHIS0

_property org.xins.common.coll ections.Propaipdradels3Dtrue%26surname
%3Dde%2BHaan

_list org.xins.common.types.standard.Ljiisevidi4R26item2%026item1

_set org.xins.common.types.standard. SétéviaBee26item1%26item?2

_base64 bytel] aGVshG8=

_hex byte(] 546573746f

_url String http://www.google.com

_descriptor org.xins.common.service.Descri ptaescriptor=group, random,
targetl, target2
descriptor.targetl=service,
http://127.0.0.1:8080/my-
project/, 8000
descriptor.target2=service,
http://192.168.0.1:8080/my-
project/, 8000
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You can find an example using al these types in the function deno\ xi ns-proj ect\apis
\'al I i none\ spec\ Si npl eTypes. f nc.

Defined types

As seen in the section called “Defining Input, Output.”, it's also possible to define your own type. Here
isalist of the possible types to definein XINS:

» <patt ern>: Thistype accepts a PERL5 regular expression and allows you to define a text that has
some constraintsin its format.

» <enunp: Thistype must contain alist of <i t en> elements, each item element must have aval ue
attribute that contains the value of the item and can have anarne attribute that contains the description
of theitem. If the name is not defined it's set by default to the value of the item.

* <int8>, <intl6>, <int32>, <i nt 64>: These types define a number. They accept the optional
attributes m n and max that can be used to set a minimum and a maximum value for the parameter.

» <f| oat 32>, <f| oat 64>: These types define a floating point number. They accept the optional
attributes m n and max that can be used to set a minimum and a maximum value for the parameter.

e <properties>: Thistypeissimilar tothe property type but it allows you to specify atype for
the keys and the values of the property by using the optional attributes nameType and val ueType.
If not specified thetype _t ext will be used.

e <l i st>and<set >: These types are used to define alist of values in a parameter. The type of the
value can be restricted by using the optional attribute t ype. If not specified the default value for the
t ype attributeis_t ext.

» <hase64>, <hex>: Thistype defines abinary. They accept the optional attributesm n and nax that
can be used to set a minimum and a maximum size in bytes for the binary.

You can find an example using some of these types in the function deno\ xi ns- proj ect\api s
\'al I i none\ spec\ Defi nedTypes. f nc.

Shared types

If you have more than one API, you may want to reuse types defined in other APIs (for example EMail.typ,
Account.typ, LastName.typ, ...). Instead of copying thefileto the new API, you can a so point to thistype.
Thisisdone by using <api nane>/ <t ype name> in api.xml and in the function(s) specification.

For example:

<type nanme="petstore/EMail"/>

<par am nane="out put EMai | " required="fal se" type="petstore/EMail">
<descri pti on>An exanpl e of output shared type.</description>
</ par anv

Grouping types

Param combos

It'salso possiblein XINSto defined agroup of i nput or out put parameters. Thereare 4 kinds of group:
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* inclusive-or

If agroupisi ncl usi ve- or then at least one of the parameters defined in the par am r ef should
have avalue.

* excl usi ve-or

If agroup isexcl usi ve- or then one and only one of the parameters defined in the par am r ef
should have avalue.

e all-or-none

If agroup isal | - or - none then either none of the of the parameters defined in the par am r ef
should have avalue or all.

e not-all

If agroupisnot - al | then at least one of the parameters defined in the par am r ef should not have
avaue.

Example:
<i nput >
<param nane="birthYear" required="fal se" type="_int32">
<description>The birth date's year.</description>
</ par anp
<par am nane="bi rt hMont h" required="fal se" type="_int32">
<description>The birth date's nonth. </ description>
</ par anp
<par am nane="birt hDay" required="fal se" type="_int32">
<description>The birth date's day. </description>
</ par anp

<par am nane="bi rt hCountry" required="fal se" type="_text">
<descri pti on>The country where the person is born.</description>
</ par anp
<param nane="birthC ty" required="fal se" type="_text">
<description>The city where the person is born.</description>
</ par anp
<par am nane="age" required="fal se" type="Age">
<descri pti on>An exanple of input for a int8 type with a m ni mum and maxi num </
</ par anp
<l-- One of the two paraneters nmust be filled but not both -->
<par am conbo type="excl usi ve-or">
<paramref name="birthYear" />

<paramref nanme="age" />
</ par am conbo>
<I-- At least one of the two paraneters nmust be filled -->

<par am conbo type="incl usi ve-or">
<paramref name="birthCountry" />

<paramref name="birthGty" />
</ par am conbo>
<l-- These paraneters nust be filled together or not filled at all -->

<par am conbo type="all-or-none">
<paramref name="birthYear" />
<param ref name="birthMnth" />
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<param ref name="bi rt hDay" />
</ par am conbo>
</i nput >

If the conditionisnot met, XINSwill returnaresult withan _| nval i dRequest error codeif therequest
does not match the input par am conbo or an _| nval i dReponse error code if the result does not
match the output par am conbo.

You can find an example using the groups in the function deno\ xi ns- pr oj ect\ api s\ al | i none
\ spec\ Par amConbo. f nc.

Attribute combos

It is also possible to defined similar constraint on attributes of elements defined in the data section (See
next chapter). Thisisdoneusingtheat t ri but e- conbo andtheattri but e-r ef elements.

Example:

<dat a>
<cont ai ns>
<cont ai ned el enent =" person" />
</ cont ai ns>
<el enent nanme="person">
<descri pti on>A person</descripti on>
<attribute name="birthCountry" required="fal se" type="_text">
<descri pti on>The country where the person i s borned. </ description>
</attribute>
<attribute name="birth-city" required="fal se" type="_text">
<description>The city where the person i s borned. </description>
</attribute>
<attribute nane="age" required="fal se" type="Age">
<descri pti on>An exanple of input for a int8 type with a m ni mrum and maxi num
</attribute>
<l-- At least one of the two attributes nmust be filled -->
<attribute-conbo type="inclusive-or">
<attribute-ref nane="birthCountry" />
<attribute-ref nane="birth-city" />
</attribute-conbo>
</ el emrent >
</ dat a>

Combos based on values

It is also possible to define constraints based on the value of one parameter (and not only on whether the
parameter is set or not). This is done by added the value attribute to the param-ref element or attribute-
ref element for attribute-combo.

Example:

<i nput >
<par am nane="sal utation" required="true" type="Sal utation">
<descri pti on>The gender of the person.</description>
</ par anp
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<par am nane="rmai denName" required="fal se" type="_text">
<descri pti on>The nmai den name. </ descri pti on>
</ par anp
<l-- If the salutation is Madam the maiden nane is required -->

<par am conbo type="incl usi ve-or">
<paramref name="sal utation" val ue="Madam' />
<paramref name="nmai denNane" />
</ par am conbo>
</i nput >

The description of the type associated with the param-combo is then a bit different:
* inclusive-or

If the parameter has the defined value then the second parameter is required.
* excl usive-or

If the parameter has the value then the other parameter should not be filled, otherwise the second
parameter is required.

e all-or-none

If the parameter has the value then the others parameters are required, otherwise the other parameters
should not be set.

* not-all
If the parameter has the value then the other parameters should not be set.

For a better understanding, look at the Par anConboVal ue. f nc function provided intheal | i none
API.

It is also possible to have more than one par am r ef with avaluein the same par am conbo.

The data section.

The data section defines a tree structure in the input or output section.

The specification

Example:

<dat a>
<cont ai ns>
<cont ai ned el ement =" property" />
</ cont ai ns>
<el enent name="property">
<descri pti on>A property name and val ue. </ descri ption>
<attribute name="name" required="true" type="PropertyNanme">
<descri pti on>The property nane. </ description>
</attribute>
<attribute name="val ue" required="true" type="_text">
<descri pti on>The property val ue. </ descri pti on>
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</attribute>
</ el enent >
</ dat a>

An element can also contain another element or text(pcdata) but not both.
To add an element in another element, add

<dat a>
<cont ai ns>
<cont ai ned el enment =" property" />
</ cont ai ns>
<el enent name="property">
<descri pti on>A property nanme and val ue. </ descri ption>
<cont ai ns>
<cont ai ned el enent =" product" />
</ cont ai ns>
<attribute nanme="nanme" required="true" type="PropertyNane">
<descri pti on>The property nane. </ description>
</attribute>
</ el ement >
<el enent name="product">

If you want your element to contain PCDATA, use

<dat a>
<cont ai ns>
<cont ai ned el ement ="property" />
</ cont ai ns>
<el ement nane="property">
<descri pti on>A property nanme and val ue. </ descri ption>
<cont ai ns>
<pcdata />
</ cont ai ns>
<attribute name="name" required="true" type="PropertyNanme">
<descri pti on>The property namne. </ descri ption>
</attribute>

Since XINS 1.1.0, it's also possible to include more than one element in the data section:

<dat a>

<cont ai ns>
<cont ai ned el enent =" packet"” />
<cont ai ned el enent="letter" />

</ cont ai ns>

<el enent nanme="packet">
<descri pti on>The packet. </description>
<attribute name="destination" required="true" type="_text">

<descri pti on>The destination of the packet.</description>

</attribute>

</ el ement >

<el ement nane="letter">
<description>The | etter.</description>
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<cont ai ns>
<pcdata />

</ cont ai ns>

<attribute name="destination" required="true" type="_text">
<descri pti on>The destination of the letter.</description>

</attribute>

</ el ement >
</ dat a>

Attributes can also have a default value using the def aul t attribute.

The implementation

Thedatasectionistranslated into a Javaobject with the appropriate set methods. Oncethe object iscreated,
you can add them to the Successf ul Resul t using provided add methods.

Example:

Successful Result result = new Successful Result();
Property myProperty = new Property();

nyPr operty. set Nanme( nmyNane) ;

nyPr operty. set Val ue(nyVval ue) ;

resul t. addProperty(nmyProperty);

return result;

If you had specified that your element could contain another element, the Pr oper t y class would also
have aaddPr oduct ( Pr oduct ) method.

If you had specified that your element could contain a text, the Pr operty class would also contain a
pcdat a( St ri ng) method.

The result

To view what kind of result to expect from a data section, we will define an example in the specification
of the function.

<out put - dat a- exanpl e>
<el enent - exanpl e name="property">
<attri but e- exanpl e nane="nane" >upgrade</ attri but e- exanpl e>
<attri bute-exanpl e nane="val ue">true</attri bute-exanpl e>
</ el enent - exanpl e>
<el enent - exanpl e name="property">
<attri but e-exanpl e nane="nane" >sur nane</ at tri but e- exanpl e>
<attri but e-exanpl e nane="val ue">Doe</ attri but e- exanpl e>
</ el enent - exanpl e>
</ out put - dat a- exanpl e>

Theresulting XML from XINS would then be

<result>

<dat a>
<property nane="upgrade" val ue="true" />
<property nane="surname" val ue="Doe" />
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</ dat a>
</result>

If your element accepted PCDATA, you can set avalue by adding <pcdat a- exanpl e>My val ue</
pcdat a- exanpl e> beforethe<at t ri but e- exanpl e>.

Y ou can find some examples of the output data section in the functions deno\ xi ns- pr oj ect\ api s
\'al I i none\ spec\ Dat aSecti on. fnc and deno\ xi ns- proj ect\api s\al | i none\ spec
\ Dat aSect i on2. f nc.

Data section for the input

Since XINS 1.1.0 it's also possible to send a data section for the request. The definition of the data section
is similar to the definition for the output section except that it must be done in the input section. The
definition of the example is done using the <i nput - dat a- exanpl e> element.

This allows you to send complex structures with XINS in the request.

The framework will generate some extra objects and methods to get the values of the input data section.
Hereisan example:

import java.util.lterator;

Iterator itAddresses = request.listAddress().iterator();

whil e (itAddresses. hasNext()) {
Request . Addr ess next Address = (Request. Address) it Addresses. next();
System out . printl n( next Addr ess. get Post code());

}

An exampleis provided with XINS in the function denmo\ xi ns- pr oj ect \ api s\ al | i none\ spec
\ Dat aSect i on3. f nc.

Since XINS 1.5.0, if you are using Java 1.5 and deploying on a Java 1.5 application server, you can also
benefit from the Java generics feature as demontrated at the end of the next section.

Data section on the client side

On the client side the data section is retreived as an or g. xi ns. conmon. xm . El enent object
(javadoc [javadoc/org/xins/common/xml/Element.html]). To get the values in the returned data section,
use the methods provided in the El enent classsuchasget Attri bute(String | ocal Nane) or
get Chi | dEl emrent s(String nane).

If you want to send a data section as input, you will need to create an
org. xi ns. common. xm . El enent (javadoc [javadoc/org/xing'common/xml/Element.html]) for
example by using the or g. xi ns. common. xm . El enent Bui | der (javadoc [javadoc/org/xing/
common/xml/ElementBuilder.html]) class. Then you can pass this object to the CAPI call method or to
the generated Request object.

Since XINS 1.3.0, the methods and objects are also generated on the client side for the data section. They
are generated the same way asthey are on the client side. For example, if you want to send alist of address
and receive alist of properties, thiswill look like this:

* For therequest:
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i mport com nyconpany. myapi . capi . MyFuncti onRequest ;

MyFuncti onRequest request = new MyFuncti onRequest();

MyFuncti onRequest . Address addressl = new MyFuncti onRequest. Address();
addr essl. set Conpany(" MDo");

addr essl. set Post code("12345");

request . addAddr ess(addressl);

» For theresult:

import java.util.lterator;
i nport com nyconpany. nyapi . capi . MyFuncti onResul t;

MyFunctionResult result = capi.call MyFunction(...);
Iterator itProperties = result.listProperty().iterator();
while (itProperties.hasNext()) {
MyFuncti onResul t. Property nextProperty = (M/FunctionResult. Property) itProperti
String propertyNane = nextProperty. get Nanme();
String propertyVal ue = next Property. getVal ue();
Systemout.println(propertyNane + ": " + propertyVal ue);

}

If you are using Java 1.5 or higher and did not set the build.java.version property to a lower version,
the generated classes will use the generics feature added to the Java language since Java 1.5. This will
simplified your code of using the code:

i mport com myconpany. myapi . capi . MyFuncti onResul t ;

MyFunctionResult result = capi.call MyFunction(...);

for (MyFuncti onResult.Property nextProperty : result.listProperty()) {
String propertyNane = nextProperty. get Nane();

String propertyVal ue = next Property. getVal ue();
Systemout. println(propertyNane + ": " + propertyVal ue);

}

Function accesses

XINS includes a way to set some permissions for the functions using ACLs and also a way to disable/
enable afunction.

ACLs

The ACLs are used to restrict the access of a function based on the IP address from where the request
Comes.

The ACLsaredefined inthe xi ns. properti es filewith the org.xins.server.acl property

The value is a dot comma separated list of the keywords al | ow or deny, the |P addresses specified as
ACL allowed or denied to access the function and the name of the function or * used for all functions.

An ACL isan |P address followed by / and the number of bits that should remains the same. For example
192. 168. 0. 0/ 24 defines dl IP addresses starting with 192. 168. 0.
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Example:

org. xins.server.acl =allow 127.0.0.1 *; \
al l ow 192. 168. 0. 0/ 24 MyFuncti on

Per default, if an |P addressisnot specified in thelist then the accessisdenied. If an IP addressis specified
twice then the first rule will apply. If you specify / O after an IP address then all IP address will match.

Example:

org.xins.server.acl =allow 127.0.0.1 *; \
deny 192.168.0.21 CetSettings; \
allow 192.168.0.21 _*; \
all ow 192.168.2.0/24 _*; \
allow 0.0.0.0/0 _GetVersion; \
al l ow 192. 168. 0. 0/ 24 MyFuncti on

In thisexample, | P addresses starting with 192.168.0. will be able to accessMyFunct i on, the IP address
192.168.0.21. will also be able to access the meta functions except the _Get Set t i ngs meta function.
All IP addresses starting with 192.168.2. will be able to access the meta functions. Everybody will be able
to accessthe _Get Ver si on metafunction.

Since XINS 1.1.0, the keyword f i | e is also accepted with as second argument the location of the file
containing the permissions. The specified file should be of a special format. The lines should start with
allow, deny or file. If theline start with allow or deny it should befollowed by the ACL and thefunction as
shown in the previous example. If the line startswith file, it should be followed by the location of another
acl premission file. Empty lines, lines containing only spaces and lines starting with # are ignored. The
ACL files will be monitored for changes every or g. xi ns. server. confi g. r el oad seconds and
will be reloaded when the meta function _Rel oadPr operti es isinvoked.

Example:

org. xi ns.server. acl =al | ow 194. 134. 168. 0/ 24 _*;\
file /usr/conf/myApp. acl

nyApp. acl :

al l ow 194. 134. 168.0/ 24 *
deny 194.134.32.0/24 *
al l ow 194.134.32.0/24 *

# conment. ..
al low 212.129.129. 120 GCet Key

Since XINS 2.1, it is possible to allow or deny a call based on the calling convention used. To do it add
after the name or the pattern of the function, the name or the regular expression pattern of the caling
convention you want to allow or deny.

For example:

org. xi ns.server.acl =al |l ow 194. 134. 168. 0/ 24 _* _xins-std|_xins-xslt;\
deny 0.0.0.0/0 _*;\
deny 0.0.0.0/0 * _xins-soap

allows the meta functions to be called only using the xins-std or _xins-xdlt calling conventions for the
given IPrange and denies any call using the xins-soap calling convention.
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Enable/Disable a function

It's also possible to enable or disable afunction. By default all functions are enabled.

To disable a function, request the following  URL: http:// APl _PATH?
_function=_D sabl eFuncti on&f unct i onName=MyFunct i on

To re-enable the function, request the URL: http:// APl _PATH?
_functi on=_Enabl eFuncti on&f uncti onNane=MyFuncti on

The links to enable or disable a function are provided on the test form generated with the specification
documentation.

HTTPS

It's also possible to use HTTPS as communication layer to call a XINS API. To do it, you just need to
configure the HTTP server (such as Apache) or the servlet container (such as Tomcat) with the correct
settings.

For more information on setting up the server, read the following articles:

» Configuring Tomcat 4.0 to use HTTPS [http://www.dga.co.uk/customer/
publicdo.nsf/0/2B4063F90912CC5D85256CB00007888B ?OpenDocument]

e Tomcat 4.0 SSL configuration How-To [http://jakarta.apache.org/tomcat/tomcat-4.0-doc/ssl-
howto.html]

» How can | support HTTPS (SSL) in a servlet? [http://www.jguru.com/fag/view.jsp?EI D=53931]

Note that HTTPS is a supported protocol on the client side only since XINS 1.3.0.

The meta functions

When you're starting a XINS server, a set of meta functions are already available. We just saw in the
Enable/Diable section thefirst two _Di sabl eFuncti on and_Enabl eFunct i on. Notethat all meta
functions start with an underscore.
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Table5. XINS Meta functions

Name

Description

_NoOp

No operation: This meta function does nothing but
maybe useful to monitor if the server isup or down
or the response time of the server.

_GetVersion

Get the running version of xml-enc, XINS, Javaand
of the API if defined.

_GetSettings

Returns the properties as set in the runtime
property file and the Java properties as returned by
Syst em get Properties().

_GetStatistics

Returns the amount of memory used and for
each function, the number of successful call, and
unsuccessful call with the response time (min, max,
last, average).

This function may have aparameter r eset =t r ue
that performs a reset of the statistics at the same
time.

This function may aso have a parameter
det ai | ed=t r ue that displays the statistics per
error code for the unsuccessful results.

_ResetStatistics

Resets the statistics.

_ReloadProperties

Reloads the XINS propertiesfile.

_CheckLinks

Checks that the API can access the other API's or
URL it'susing.

This meta function will test the URLs set in the
runtime propertiesfile where the property is defined
in the i npl . xm file with the type _url or
_descriptor.

_GetFunctionList

Returnsthe list of the functions.

_DisableFunction

Disables the function passed in the functionName
input parameter.

_EnableFunction Enables the function passed in the functionName
input parameter.

_DisableAPI Disables the APl by returning HTTP 503 to all
reguests.

_EnableAPI Re-enables the API that was disabled.

_WSDL Returns the WSDL [http://www.w3.0org/TR/wsdl]
of the API.

_SMD Returns the Simple Method Description [http://

dojo.jot.com/SMD] of the API.
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Management

As XINS APIs are standard Servlets, most of the management can be done by the Servlet container or
the J2EE application server. Most of the management specific to the APl is done by editing the runtime
property file. See.

JMX

JMX MBeans have been added since XINS 1.5.0 to have the possibility to manager the API using standard
management tool s sush as HP Openview or the JConsole included in the JDK.

The following information are available through the IMX interface:

+ Statistics

» Bootstrap properties

* Runtime properties

* XINSversion running

* APl version

 Startup time

» Thelist of the functions

Y ou can aso perform the following actions:

» noOp(): Function that does nothing but can be used to check if the API is up.

» reloadProperties(): Reload the runtime properties.

Log4dJHi er ar chyDynamni cMBean isaso registered as MBean.

The object names used for both MBeans startswith or g. Xi ns. server. <api nane>.
By default, IMX isdisabled. To enableit set the runtime property org.xins.server.jmx=true.

To have an overview execute xins run-myproject with Java 1.5 or later and run the j consol e. exe
located inj dk\ bi n.

Versioning

You can aso set aversion to your API.

To set the APl version create a . ver si on. properti es file in the project directory with the 2
following properties defined: ver si on. maj or andver si on. ni nor.

The version will be apply to al APIs. If you want a specific version for one of the API, create a
.version. propertiesintheapi s\ <api name> directory.

Shared instance

In XINS the functions are initialised when you start the server, theinitialisation also passes the properties
definedinxi ns. properti es tothefunction. XINS hasthe notion of shared instance whichisan object
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created and initialized in a similar way as functions are. Furthermore this object is passed as an instance
to all the defined functions of the API.

Y ou can think about the following situations:

 You want to access a database or an access to LDAP with the access properties set in
Xi ns. properti es.

* You want to share data between functions.

To add a shared instance to the APl add in the inpl.xm file <instance
nanme="_sharedChj ect"” getter="get SharedCbj ect" cl ass="SharedCbject" />.

Now you need to create a class Shar edCbhj ect in the implementation package that extends
the or g. xi ns. common. manageabl e. Manageabl e class (javadoc [javadoc/org/xinsg/common/
manageabl e/Manageable.html]).

Now you could use this object by calling in the call(Request request) method

/1l Get sonme data fromthe shared object
String firstName = _sharedj ect. get Fi rst Nane(request. get Last Narme());

An exampleisprovidedintheal | i none project.

Calling Convention

Since version 1.0.1, XINS has the notion of calling convention.

A calling convention specified the format of the request and the format of the result. You can seeit asa
communication protocol.

XINS 1.1.0 includes the following calling conventions: _xi ns-std, xi ns-ol dand_xi ns-xm .

XINS 1.2.0 includes the _xi ns- xsl t calling convention and alows to define it's own custom calling
convention.

XINS 1.3.0includesthe xi ns- soap and _xi ns-xm r pc caling conventions.

XINS 1.4.0 includes the automatic detection of the calling convention meaning that if no _convention
parameter is sent and no custom calling convention is defined, XINS will try to detect the calling
convention to call based on the format of the request.

XINS 1.5.0 includes the XINS front-end calling convention: xinsff. A front-end framework user guide
[frontend/index.html] isalso included in the release. It is &l so possible since this version possible to define
the supported HTTP methods for a custom calling convention. This can be useful if you want to define a
REST [http://en.wikipedia.org/wiki/REST] calling convention. A new example was also added that uses
aMul tipartCallingConventi on toreceivebinariesfiles.

XINS 2.0 includes the _xi ns-j son and _xi ns-j sonr pc caling conventions. The _xi ns-ol d
calling convention has been removed in this release.

XINS 2.1includesthe Xxi ns- soap- map calling convention.

How to define the calling convention

If nothing is specified the standard calling convention (asin XINS 1.0.0) is used.
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If the calling convention can be set, by adding the _convent i on parameter to the URL with the value
of the calling convention as argument.

Thedefault calling conventionfor an API canbe specifiedinthei nmpl . xm fileby addingthecal | i ng-
convent i on element. For example:

<i npl >
<cal | i ng- conventi on nane="_xins-xm" />
</inpl>

Standard calling convention

The standard calling convention or also named POX-RPC calling convention is the default calling
convention used by xins. If no caling-convention is included in the i npl.xm file and no
_convent i on parameter is passed in the request, XINS will expect an request using this convention and
return aresult using this convention. The property value for the POX-RPC calling conventionis_xi ns-
st d. This calling convention is aso known as the standard calling convention.

This examples provided in this document are using the POX-RPC calling convention. The examples
generated with the specdocs and the test forms are al so using this calling convention.

A document (link [protocol/index.html]) isalso provided inthedocs\ pr ot ocol directory that contains
the specifications of this calling convention.

XSLT calling convention

The property value for the XSLT calling convention is _xi ns-xsl t. The request is similar to the
standard calling convention (using URL). The result returned is the result of the processing of the XML
normally returned with the standard calling convention with a specified XSLT file. This means that the
result could beaHTML page or XML or plain text or binary depending on the XSLT transformation.

The location of the XSLT stylesheets is set using the runtime property tenpl at es. <api
name>. xi ns- xsl t. sour ce. This property refersto the directory wherethe XSLT stylesheets can be
found. The stylesheets then must have the name of the function with the. xsl t extension.

Y ou can also pass the location of the template in the request with the _t enpl at e parameter. This will
override the previous runtime property. Thelocation should be relative to the path or URL specified inthe
runtime property t enpl at es. <api nane>. xi ns-xsl t. paranet er. prefi x. If this property
isnhot set the _t enpl at e parameter is not allowed.

The XSLT calling convention caches the templates for better performances. You can clear the cache by
passing the cl eart enpl at ecache=t r ue parameter. Y ou can aso disable the cache by setting the
t enpl at es. cache runtime property tof al se.

SOAP calling convention

The property value for he SOAP calling convention is _xi ns- soap. The SOAP caling convention
allows you to cal the APl using SOAP. SOAP is a W3C [http://www.w3.0rg/TR/soap/] standard
communication protocol for Web Services. The SOAP calling convention allows to provide to external
software and companies a way to communicate using a standard protocol. The SOAP calling convention
allows also to use XINS with WS-BPEL [http://www.oasi s-open.org/committees/wsbpel/charter.php] or
JBI [http://java.sun.com/integration/].
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Example of an input request:

<?xm version="1.0" encodi ng="UTF-8""?>
<soap: Envel ope xm ns: soap="http://schenmas. xm soap. or g/ soap/ envel ope/" xm ns: ns0="u
<soap: Body>
<ns0: Dat aSect i on3Request >
<i nput Text >Hel | o</ i nput Text >

<dat a>
<addr ess company="MDo" postcode="1234" />
<address company="Drill" postcode="4567" />
</ dat a>

</ ns0: Dat aSect i on3Request >
</ soap: Body>
</ soap: Envel ope>

SOAP is often associated with a WSDL file that describes the Web Service. XINS can generate this
WSDL file by executing xins wsdl-<api name>. This generated file is located in the directory bui | d
\ webapps\ <api >. Note that the generated WSDL file also contain the XML Schema for the standard
types, the defined types, the required fields or the optiona fields. By default the endpoint defined in
the WSDL is the first environment defined in the environment XML file or if there is no file defined
http://1 ocal host/ <api name>/?_convention=_xi ns-soap. You can set the endpoint
by passing the command line argument - Dnsdl . enpoi nt or by setting the wsdl.endpoint property in
bui | d. properti es file. You can then use this generated file in the Web Services client sush as C#,
Visual Basic, PHP, Perl.

The SOAP calling convention and the generation of the WSDL have been developed based the WS-
| Basic Profile Version 1.1 [http://www.ws-i.org/Profiles/BasicProfile-1.1-2004-08-24.html]to ensure
better compatibility with other frameworks.

XML calling convention

The property value for the XML calling convention is_xi ns- xmnl . In this case only HTTP POST are
accepted. The returned output isthe same as the standard calling convention. Example of an input request:

<request function="functionNane">
<par am nane=" par anNane" >par anVal ue</ par ane
<dat a>
<product name="sonet hi ngl" price="12.2" />
<product name="sonet hi ng2" price="23.5" />
</ dat a>
</ request >

XML-RPC calling convention

The property value for the XML-RPC calling convention is _xi ns-xm rpc. XML-RPC is a
specification used to remote procedure call using XML over HTTP. XML-RPC has client frameworksin
alot of languages including AppleScript, 2ME, Ruby.

Example of an input request:
<?xm version="1.0"7?>

<met hodCal | >
<nmet hodNane>Si npl eTypes</ net hodNane>
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<par ans>
<par anmp<val ue><st r uct ><nmenber >
<nane>i nput Bool ean</ nane>
<val ue><bool ean>0</ bool ean></ val ue>
</ menber ></ st r uct ></ val ue></ par anv
</ par ans>
</ met hodCal | >

For more information on XML-RPC, visit the web site at http://www.xmlrpc.com/.

JSON-RPC calling convention

The property value for the JSON-RPC calling convention is _xi ns-j sonr pc. JSON-RPC is a
specification used to remote procedure call in different Ajax frameworks such as the DOJO toolkit. The
specification of JSON-RPC arelocated at http://json-rpc.org/wiki/specification. Both specification version

(1.0 and 1.1) are supported by the JSON-RPC calling convention.

Example of an input request for JSON-RPC 1.0:

{"method": "ResultCode", "parans": ["Hallo"], "id": null}

Examples of ouput result for JSON-RPC 1.0:

{"result": {"outputTest": "Hallo"}, "error": null, "id": null}

{"result": null, "error": "AlreadySet", "id": null}

Example of an input request for JSON-RPC 1.1:

{"version": "1.1", "method": "ResultCode", "parans": {"inputText": "Hallo"}}
http://ww. myserver. com pat h/ Resul t Code?i nput Text =Hal | 0

Examples of ouput result for JSON-RPC 1.1:

{"version": "1.1", "result": {"outputTest": "Hallo"}}

{"version": "1.1", "error": {"nane": "AlreadySet", "code": 123, "nmessage": "The pa

For more examples, visit the web site at http://json-rpc.org/.

The automatic detection of the matching calling convention for arequest will only find request using the
1.1 specifications.

JSON calling convention

The property value for the JISON calling convention is_xi ns- j son. This calling convention is based
on the Yahoo! JSON protocol specified at http://devel oper.yahoo.com/common/json.html. This includes
the support for the callback parameter.

Example of an input request:

http://ww. myserver. com pat h/ Resul t Code?i nput Text =Hal | o&out put =j son
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Examples of ouput result:

{"output Test": "Hallo"}

Example of an input request with callback:

http://ww. myserver. com pat h/ Resul t Code?i nput Text =Hal | o&out put =j son&cal | back=proce
Examples of ouput result with callback:

process({"output Test": "Hallo"})

This calling convention could be useful if you want to call the API from GWT [http://code.google.com/
webtoolkit/] (Google Web Toolkit).

SOAP-MAP calling convention

The property valuefor the SOAP-Map calling conventionis_xi ns- soap- map. Thiscalling convention
accepts SOAP requests and applies the same mapping for the request or the response as what is done in
the xins wsdl-to-api command.

Thismeansthat if you need to write aweb service using a pre-defined WSDL, you can do it by executing
xi ns wsdl -to-api command and pass _conventi on=_xi ns- soap- map in the URL query
parameters.

The calling convention will copy the Envelop and Body XML elements as what received in the
request, try to keep the same namespaces prefix and map data element attributes to sub-elements. If
after the transformation not all parameters are detected and mapped correctly, you can also extend the
org.xins.server.SOAPMapCallingConvention and implement you own parsing on specific parts or create
your specific response.

Custom calling convention

To create your own calling convention, you need to extend the
org. xi ns. server. CustontCal | i ngConventi on class (javadoc [javadoc/org/xing/server/
CustomCallingConvention.html]).

This class has two abstract methods, conver t Request | npl and convert Resul t | npl , that you
must implement.

Notethat the Cust ontCal | i ngConvent i on extendsthe Manageabl e class, thismeansthat you can
read the bootstrap settingsintheboot st r apl npl method and the runtime propertiesinthei ni t | mpl
method.

To define the calling convention in the i npl . xm , you need to add an extra argument cl ass to the
cal I i ng- conventi on element. For example:

<i npl >
<cal | i ng- conventi on nanme="my-convention" class="com myconpany. nyproj ect. MyConven
</inpl>

Y ou can also define more than one calling convention, in this case one calling convention must have the
attribute def aul t ="t rue".
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Example:

<i npl >
<cal | i ng- conventi on nane="_xins-std" default="true" />
<cal | i ng- conventi on nane="nmny-convention" class="com myconpany. nyproj ect. M/Conven

</inpl>

More information on how to create your own calling convention is provided in the calling convention
primer [http://xins.sourceforge.net/ccprimer.html].

You can aso look at the fil eupload APl provided in the examples that defines a
Cust onCal | i ngConvent i on in order to upload binariesfiles.

Examples calling convention

Severa custom calling conventions are provided in the examples. Some of them are not included in the
core libraries so if you want to use them, you will need to copy the file to your project.

Hereisalist of the custom calling convention used in the examples:

* MultipartCallingConvention isdefinedinthefil eupl oad API. This calling convention
alowsto receivefiles according to the HTTP file upload protocol. This calling convention requires the
commons-fil eupl oad. j ar includedinapi s\ fil eupl oad\ | i b directory.

* RESTCal | i ngConventi on isdefinedinther est API. Thiscalling convention only accepts strict
REST [http://en.wikipedia.org/wiki/Representational_State Transfer] requests.

e The pet st or e example uses the Fr ont endCal | i ngConvent i on which is a custom calling
convention added to the core. More information about this calling convention can be found inthe XINS
Front-end Framework manual [frontend/index.html].

Utility classes

XINS also contains in the org.xins.common package, a set of classes that could be useful for the
implementation of your API.

Note also that the following APIs are distributed with al XINS applications: HTTPClient API [http:/
jakarta.apache.org/commong/httpclient/], commons logging [http://jakarta.apache.org/commons/logging/
], commons codec [http://jakarta.apache.org/commons/codec/], Log4j API [http://logging.apache.org/
logdj/docs/index.html], Jakarta ORO APl [http://jakarta.apache.org/oro/] and xmlenc [http:/
xmlenc.sourceforge.net/]. Y ou can then use these APIs without adding any dependency element in the
i mpl . xm file.

» Spec package

The spec package is located in org.xins.common.spec (javadoc [javadoc/org/xins/common/spec/
index.html]). This package contains classes that provide information on the specification of the API.
Y ou can get the specification from the client side by using capi . get APl Speci fi cati on() and
from the server side using api . get APl Speci fi cati on() . The method will return a APl Spec
object from which you will be able to get all the specification of the API. Y ou can get information sush
asthelist of the functions, the type of a parameter in afunction, the error code returned by a function.

o HTTPServiceCaller
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The org.xins.common.http.HTTPServiceCaller (javadoc [javadoc/org/xins/common/http/
HTTPServiceCaller.html]) isaclassthat isused to get information from aURL. Thisclass also supports
load-balancing and fail-over via the GroupDescriptor such as the XINSServiceCaller does. This class
has a call method that requires a HTTPCallRequest as input where you can specify the method to
call the URL, the parameters of the URL and the behaviour for the fail-over, and this call returns a
HTTPCallResult where you can get the returned text as String, byte[] or as InputStream as well as the
HTTP code returned.

» ExpiryFolder

The  org.xins.common.collections.expiry.ExpiryFolder ~ (javadoc  [javadoc/org/xins/common/
collections/expiry/ExpiryFolder.html]) class allows you to store some properties (key & value pairs) for
alimited amount of time. When a property is added, it has the maximum time to live. If the property is
not requested during this time then the property is removed. If the property is requested using the get()
method then time to live of this property is set again to the maximum.

The ExpiryFolder is particularly interesting if you want to implement caching of the result. More for
look at the online article [http://xins.sf.net/resultcaching.html] explaining how to do result caching for
amethod.

» BeanUtils
The org.xins.common.BeanUltils (javadoc [javadoc/org/xins/common/BeanUtils.html]) class allows to
copy the properties of a POJO to another POJO. It can useful to fill a generated Request object on the
client side or a SuccesfulResult object on the server side. Especialy if you use libraries such as JPA
(Java Persistence API) or the Spring Framework. It is also useful when you want to forward a request
or when the result of afunction call should be used as input to call another function.

If the names of the properties are different, you can also provide a mapping of the properties name as
parameter, element name or attribute name. The method will also convert the types whenever possible.

» FileWatcher
The org.xins.common.io.FileWatcher (javadoc [javadoc/org/xins/common/io/FileWatcher.html]) class
alowsyouto monitor afilefor changes. Y ou just need to specify thefileto monitor, theinterval between
two checks of the file and the listener that will be notified when the file has changed. Don't forget to
invoke the start() method to start the monitoring of thefile.

* Optimized classes

The org.xins.common.text (javadoc [javadoc/org/xins/common/text/URLEncoding.html]) package
contains classes for URL encoding, URL decoding or creation of regular expression patterns.

Ant tasks

Before using the tasks, you need to define them using the following lines:

<property environnent="env" />
<t askdef resource="org/xi ns/comon/ant/antlib.xm" classpath="${env. XINS HOVE}/b

callxins task

Thecal | xi ns task isused to call axins API. The result of the call isthen stored in properties.
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Example:
<cal | xi ns functi on="MFunction”
| ocation="http://1ocal host: 8080/ myproject/"
prefix="myapi ">
<par am nane="gender" val ue="ni" />
<par am nane="per sonLast Nane" val ue="Lee" />
</ cal | xi ns>

This task will call the MyFunct i on function of the mypr oj ect API. The result will be store in the
myapi.message Ant property as MyFunct i on just returns one output parameter named nessage.

Thepr ef i x attributeis optional.

If the function returns a data section, the properties will be set as described in the Ant XML property task
[http://ant.apache.org/manual/CoreTasks/xmlproperty.htmi].

xins task

The xins task is used to execute axins target. If the specifications have changed this target will take care
of recreating the build.xml and calling the requested target.

If you execute the script from another directory, you will need to define the pr oj ect di r optiona
attribute.

Example:
<xi ns api ="nyproject" target="specdocs" />
Note that the api attribute is optional:

<xins target="create-api" />

XINS targets

Hereis adescription of the most useful targets.
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Table 6. XINStargets

Target name Description

run-<api> Runs the WAR for the API.

war-<api> Createsthe WAR for the API.

specdocs-<api> Generates all specification documentation for the
API.

javadoc-api-<api> Generates Javadoc APl documentation for the API.

server-<api> Generates the war file, the Javadoc AP
documentation for the server side and the specdocs
for the API.

jar-<api> Generates and compiles the Java classes for the

client-side API.

javadoc-capi-<api>

Generates Javadoc APl docsfor theclient-side API.

client-<api> Generates the specdocs, the Javadoc API docs for
the client side, the CAPI jar file and a Zip file
containing al of this.

clean-<api> Cleans everything for the API.

rebuild-<api> Regenerates everything for the API.

al-<api> Generates everything for the API.

wsdl-<api> Generates the WSDL of the API.

stub-<api> Generates the API stub.

test-<api> Generates the unit tests if needed and tests the API.

javadoc-test-<api>

Generates Javadoc for the unit test of the API.

opendoc-<api>

Generates the specification of the API in open
document format.

al Generates everything.

clean Removes all generated files.

specdocs Generates all specification docs.

clients Generates client-<api> for all APIs.
javadoc-capis Generates the Javadoc for all CAPIs.
javadoc-apis Generates the Javadoc for all APIs.

wars Creates the WARsfor all APIs.

tests Runs the unit tests of the APIs that have tests.
create-api Generates anew api specification file.

create-function

Generates a new function specification file.

create-rcd

Generates anew error code specification file.

create-type

Generates a new type specification file.

create-example

Generates a new example for afunction.

create-logdoc

Generates the basic logdoc files for an API.

version or -version

Prints the version of XINS.

help

Prints the possible targets along with the possibles
APIs.
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XINS tools

XINS can also execute severa tools that can improve the quality of your API.
To useit, execute xins <tool target>.

The target will ask you upon which APl you want to execute the tool. You can aso pass the name of
the APl as a parameter name using - Dapi . nanme=<api nane> or add an api.name property to the
bui | d. properti es file

Y ou need to have the required librariesin the XI NS_HOVE\ | i b directory, unless specified otherwise.
» Xinshelp-tools

Description: Prints the list of the tool targets with its description and its required or optional build
properties.

 xinsdownload-tools
Description: Downloads and installs the required libraries needed to execute the tools.
» xinsjavazhtml
Description: Generates HTML pages which contain the source code of the API.
Required library: j2h.jar [http://www.ibiblio.org/maven2/javazhtmi/j2h/1.3.1/j2h-1.3.1.jar]
Web site: http://www.java2html.de/
Result location: bui | d\ j 2h\ <api nanme>\i ndex. ht m
* xinspmd

Description: Analyses the source code of the API. The default rules set is rul esset/
basi c. xm , rul esset/unusedcode. xm . You can override it by settting the pmd.rules

property.

Required library: pmd.jar [http://www.ibiblio.org/maven2/pmd/pmd/3.7/pmd-3.7.jar] and jaxen [http://
www.ibiblio.org/maven2/jaxen/jaxen/1.1-beta-11/jaxen-1.1-beta-11.jar]

Web site: http://pmd.sourceforge.net/
Result location: bui | d\ pnd\ <api nanme>\i ndex. ht m
e Xinscheckstyle

Description: Checks the source code for compliance to the Java
coding convention  [http://xins.sourceforge.net/X 1N S%20Java%20Coding%20Conventions%20-
%20v1.0%20-%20July%202006.pdf]. It also perform some analisys of the code.

Required library: checkstylejar [http://www.ibiblio.org/maven/checkstyle/jars/checkstyle-4.1.jar]
commons-beanutils.jar [ http://www.ibiblio.org/maven/commons-beanutil §jars/commons-
beanutils-1.7.0.jar] antlr.jar [http://www.ibiblio.org/maven/antlr/jars/antlr-2.7.6.jar]

Web site: http://checkstyle.sourceforge.net/

Result location: bui | d\ checkst yl e\ <api nane>\i ndex. ht m
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 Xinscoverage
Description: Reports on the coverage of the API code by the unit tests.

Required libraries: cobertura.jar [http:/iwww.ibiblio.org/maven2/cobertura/cobertura/1.8/
cobertura-1.8.jar], asm.jar [http://www.ibiblio.org/maven2/asm/asm/2.2.1/asm-2.2.1.jar]

Web site: http://cobertura.sourceforge.net/
Result location: bui | d\ cover age\ <api nanme>\i ndex. htmi
* Xinsemma

Description: Reports on the coverage of the API code by the unit tests using the EMMA code coverage
library.

Required libraries; emmajar [http://mirrors.ibiblio.org/pub/mirrors/maven2/emma/emmal2.0.5312/
emma-2.0.5312 jar], emma_ant.jar [http://mirrors.ibiblio.org/pub/mirrors/maven2/emma/
emma_ant/2.0.5312/emma_ant-2.0.5312.jar]

Web site: http://emma.sourceforge.net/
Result location: bui | d\ cover age\ <api nanme>\i ndex. ht m
» xinsfindbugs

Description: Analyses the code in order to indentify possible bugs. You will need to set the
findbugs.home=<findbugs directory> build property.

Required library: Install findbugs.zip [http://surfnet.dl.sourceforge.net/sourceforge/findbugy
findbugs-1.1.1.zip].

Web site: http://findbugs.sourceforge.net/
Result location: bui | d\ f i ndbugs\ <api nanme>\i ndex. ht m
e Xxinslint4j
Description: Analyses the code in order to indentify possible bugs.
Required library: lint4j.jar [http://www jutils.com/maven/lintdj/jars/lint4j-0.9.1.jar]
Web site: http://www.jutils.com/

Result location: bui | d\1int4j\<api name>\lint4j-report.txt and buil d\Ii nt 4]
\<api name>\lint4j-report.xmn

» Xinsjdepend
Description: Analyses the package dependency and generates design quality metrics.

Required library: jdepend.jar [http://www.ibiblio.org/maven/jdepend/jarsjdepend-2.9.1.jar] in the
ANT_HOVE\ | i b directory.

Web site: http://clarkware.com/software/IDepend.html
Result location: bui | d\ j depend\ <api nanme>\i ndex. htni

» Xinscvschangelog
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Description: Generates the change log report of the API.
Required library: None but cvs should be installed.

Result location: bui | d\ cvschangel og\i ndex. ht m
xinsglean

Description: Generates a Glean report for the API. Glean is a tool agregator that produce a feedback
repost about the source code. Y ou will need to set the glean.home=<Glean directory> build property.
If not already provided, aapi s\ <api nane>\ gl ean. properti es fileis created that you can
customize to your wishes.

Required library: Install glean.zip [http://jbrugge.com/glean/glean-1.2.zip].
Web site: http://jbrugge.com/glean/

Result location: bui | d\ gl ean\i ndex. ht m

Xinsjmeter

Description: Generates JMeter [http://jakarta.apache.org/jmeter/] tests from the examples defined in the
functions.

Required library: None.

Web site: http://jakarta.apache.org/jmeter/

Result location: bui | d\ j met er\ <api nane>\<api nanme>. | nx
Xinsrun-jmeter

Description: Runsthe IMeter tests. Y ou will need to the set jmeter.home=<jmeter directory> property.
You can set the jmeter.test property for the location of the tests without the extension. The default is
the location of the generated tests.

Required library: Install IMeter [http://jakarta.apache.org/jmeter/].

Web site: http://jakarta.apache.org/jmeter/

Result location: bui | d\ j net er\ <api name>\i ndex. ht m

xins maven

Description: Generates the Maven [http://maven.apache.org/] pom xmi file for the specified API.
Required library: None.

Web site: http://maven.apache.org/

Result location: api s\ <api name>\ pom xm

xinssmd

Description: Generates the SMD [http://maven.apache.org/] (Simple Method Description) of the API.
Y ou can set the destination of the API with the smd.endpoint property. The default is the first address
intheenvi ronment . xm filewith?_conventi on=_xi ns-j sonrpc.
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Required library: None.
Result location: bui | d\ snd\ <api nane>. snd
xins xsd-to-types

Description: Generates .typ fileswith the types defined in the given XML Schemafilesfor the specified
API.

Parameters: xsd.dir - Directory containing the XML Schema files (*.xsd)
Required library: None.

Result location: api s\ <api nanme>\*.typ

xins wsdl-to-api

Description: Generates an API specification based on a WSDL [http://www.w3.org/TR/wsdl] file or
URL.

Parameters: wsd.location - The location of the WSDL (local file or URL)
Required library: None.

Result location: api s\ <api nanme>\api . xm apis\<api nanme>\*.fnc api s\ <api
nanme>\*.typ api s\ <api nane>\*.rcd

xinswebstart

Description: Generates a Java WebStart file (also called INLP file) to run the API.
Required library: None.

Result location: bui | d\ webst art\ <api nane>.jnlp

Note you will need to sign the WAR file if you want to make the APl available online.

Content of the XINS package

This chapter gives a description of the files and directories included in XINS package, so that you can
find the wanted information quicker.

Documentation

In the top directory of XINS, the following documents are available:

README. ht ml contains a quick description of XINS, links to the documentation and quick start to
run asmall project.

CHANGES contains the change logs between each releases.

NOTES contains the rel ease notes with the known bugs and the OS and Java version with which XINS
has been tested.

The docs directory contains the following documents:
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e Theuser guide (it's this document)

» The Javadoc of the XINS.

e The XINS primer. The primer is a description step by step on how to create your first API.
* HTML Logdoc. This document contains a description of the message logged by XINS.

» The XINS protocol. This document explains the communication protocol for the REST calling
convention.

Examples

Three API examples are distributed with XINS. The API's are located in the directory deno\ xi ns-
pr oj ect.

Here is adescription of the API's:
* nyproj ect : Thisexampleisavery basic example, much like a"Hello World" example.

e al | i none: Thisexample uses most of the featuresincludingin XINS. The API contains 1 new feature
per function.

o filteredproject: Thisexampleisan API that uses the generated CAPI to call another API (the
myproject API).

The examples a so include client examples. This shows how to call an API using different programming
languages.

The most interesting examples are the Ajax [http://en.wikipedia.org/wiki/Ajax_%28programming%29]
examples located in the directory deno\ capi s\ j avascri pt . These examples show how to call a
XINS API synchroniously or asynchroniously with Javascript and insert the result in the current HTML
page. XINSworks particularly well with Ajax thanksto the REST calling convention and the XSLT calling
convention.

Hereisadescription of the Ajax examples:

e cal | MyFuncti on. ht m calsthe XINSAPI using the REST calling convention and insert the result
of the call in the web page.

» cal | MetaFuncti on. ht m callsthe XINS APl using the XSLT calling convention and insert the
HTML returned by the call in the web page.

e cal | MyFuncti on2. ht M calsthe XINS API using the REST calling convention and tranform the
returned result using XSLT on the client side. It then insertsthe HTML in the web page.

Note

Because of security issues, when these examples are executed locally using Netscape as browser,
cal | MyFunction. ht M will ask for authorisation, cal | Met aFuncti on. ht m will fail
andcal | MyFunction2. ht m will fail.

XINS aso contain examples on how to call an APl using PHP version 4 and 5, Perl and Java. If you want
to call aXINS API using another language, just call the API using the URL and parse the returned XML.
Y ou can a'so use the SOAP calling convention or the XML-RPC calling convention.
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Program

The package not only contains the documentation and the examples, it contains also the program :-).

The program islocated in different directories:

* bi n contains the shell scripts. This directory should be in you PATH environment variable.

* bui I d containsthe XINS library.

* | i b containsthe third party libaries used by XINS with their license.

» src contains XINS source code aswell asthe XSLT, XML and cssfiles used for the code generation.

A Antbui | d. xm script is provided in the root directory in the case you want to recompile XINS.

Integration with IDE

This chapter will help you to configure a development environment so that you can create, develop, test
and debug a project faster.

If you have found some more settings that helped you to develop the XINS API faster using Eclipse, send
the procedure to anthony.goubard@japplis.com [mailto:anthony.goubard@japplis.com].

Integration with Eclipse.

The Eclipse version used for thismanual is 3.2 and can be found at http://www.eclipse.org/platform.

Note

As described in the install section, if you're using the Ant distribution included with
Eclipse, you may need to copy xercesimpl-2.6.2.jar [http://www.ibiblio.org/maven/xercedjars/
xercesimpl-2.6.2.,jar] to the pl ugi ns\ org. apache. ant _1. 6. 5\ | i b directory to avoid
putDocumentInCache error messages. If you still have the error, install Ant and go to Window -
> Preferences -> Ant -> Runtime -> Ant Home... and choose the Ant directory.

As Eclipse locks the opened files, you choose close them before calling the create-xxx targets.
For example xi ns- pr oj ect s. xm should be closed before calling cr eate-api.

xins eclipse

If the xins-project.xml is not already created, create it in a new directory with the content specified in
the section called “xins-project.xml”.

In Run -> External Tools -> External Tools, create a new program with the name xi ns, the location
set to the xi ns\ bi n\ xi ns. bat file and the working directory to the directory containing xi ns-
pr oj ects. xml . Thenyou need to add in theargumentsthe ${ st ri ng_pr onpt } variableand add
in environment the variable XI NS_HOVE with the value of the XINS directory.

If the API is not created, click on the run button and enter cr eat e- api . Thistarget will ask a series
of question in order to create the API including the first function of the API.

Click on the run button and enter ecl i pse. Enter the name of the API.

The command will create a xi ns-eclipse.userlibraries in the xi ns\src\tools
\ ecl i pse directory. Then go to Window -> Preferences -> Java -> Build Path -> User Libraries -
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> Import... -> Browse and select the xi ns- ecl i pse. userli brari es file. This step only needs
to be done once.

* After the eclipse command, depending on the directory location of the api:
« If your project is outside your workspace, choose File -> New -> Project... -> Java -> Java Project ->
fill the project name -> Create project from existing source and choose the apis\<api name> directory

-> Finish.

 If your project is in your workspace, choose File -> Import... -> General -> Existing Projects into
Workspace -> Next -> choose the apis\<api name> directory -> Finnish.

Run it with Tomcat plug-in.

In order to be able to run and debug your web application, you'll need to instal Tomcat
(http://jakarta.apache.org/tomcat/) and the Tomcat plug-in for Eclipse (http://www.sysdeo.com/eclipse/
tomcatplugin).

Configure the Tomcat plug-in in the Preferences:
 Set the Tomcat home to the location where you have installed Tomcat

* Add, in the JVM settings, the JVM parameter - Dor g. Xi ns. server. confi g=c:\java
\tontat\conf\xins. properties (the xins.properties could aso be in another
directory). For more details about the xi ns. properti es, read the section called “The runtime
properties’.

» Changethe Configuration fileto api s\ <api nane>\tontat - server. xm .

» Start Tomcat.

Run it and debug it with Jetty plug-in.

You can aso use the Jetty plug-in for Eclipse. To instal it, go to Help -> Software Updates -> Find and
Install... -> Search for new featuresto install -> Add Update Site. Then enter the name JettyL auncher and
the URL http://jettylauncher.sourceforge.net/updates/.

» Create an Jetty XML fileto link adirectory to the bui | d/ webapps/ <api >/ <api >. war file.
* GotoRun->Run...

 Create anew Jetty Web project

» Set aname for the project, set the Jetty home

* Click on Use a Jetty configuration file and set the value to the Jetty XML file you've created

» Go to the argument tab and add the parameter - Dor g. xi ns. server. confi g=<jetty_hone>
\et c\ xi ns. properties.

» Now you can run, add breakpoints and debug your web application using the buttons on the toolbar
Other improvements.

With Eclipse, by changing the code and saving it you can run your modification without recompiling if
the modification isminimal. If you modified alot of code, you will need to regenerate the war file.
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If you have aso generated the specific documentation you may want to use the test forms or the example
to test your project. To do so, create anew External tool named specdocs with the main program linked to
your HTML Browser and the arguments set to bui | d\ specdocs\ <api >\ i ndex. ht il file.

In order to be able to edit the specifications that are in XML, we also advise that you instal a
XML plug-in for eclipse such as XMLBuddy (http://www.xmlbuddy.com/) or XML Author (http://
www.svcdelivery.com/xmlauthor/). Then in Preferences -> Workbench -> File Associations, add * . f nc,
* . typand*.rcd associated with the XML tooal.

If you execute the cl ean target, you may have afterwards a window popping up asking you to choose

between bui I d. xml andbui | d. xm (1) . To remove thiswindow go to External Tools... menu and
removethebui I d. xm (1) configuration.

Integration with NetBeans

The version of NetBeans used for this manual is 5.0 and can be downloaded at http://www.netbeans.org/.
Setting up the project.

An Ant script for NetBeans 5.0 or higher is provided with XINS. It requires a correctly set XI NS_HOVE
environment variable.

» AddtheDTD catalog by clicking on the runtimetab, right click onthe DTD and XML Schema Catalogs
item and add the OASIS catalog located at sr ¢\ dt d\ xi nsCat al og. xmi .

* Register someextensionas XML filesinTool s -> Opti ons -> Advanced Options -> | DE
Configuration -> System -> Cbject Types -> XM.Objects -> Extensions
and M ME Types by adding theitemsf nc, t yp, r cd and cat . Check also at the same time the
XML Indentation Engine settings.

* Openthe project in deno\ xi ns- proj ect\ api s\ pet store.

« If the API already exists, executethe copy- nb-fi | es target of thenbbui | d. xmi .

 If you want to create a new API, execute the cr eat e- api target. This target will ask a series of
guestion in order to create the APl including the first function of the API.

» Open the project by selecting the directory of the API: <pr oj ect dir >\ api s\ <api nane>

* You can now open your function implementation file and write it's implementation in the Resul t
cal | (Request request) method.

 Click on the Compile button to compile, on the Run button to run your API, on the Debug button to
debug it or on the Apply Code Changesif you have modified the code with debugging.

» Toprofilethe API, install NetBeans profiler (http://profiler.netbeans.org/) and executethe profil e target.

In NetBeans, the targets can be executed by right-clicking onthe nbbui | d. xm and Run t ar get or
by right-clicking on the project icon or by using the toolbar if your project is the main project.

In NetBeansyou can set conditional breakpoints or exception breakpointsthat stop the debugger whenever
an exception is thrown.

Targetsto deploy your APl in Tomcat are provided. Y ou can then use the Netbeans HTTP Monitor withit.
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Integration with other frameworks

XINS is based on severa standard such as POJO, Servlet API, SOAP, REST or Ant which eases the
integration with other frameworks.

Spring framework

XINS can easily be integrated with the Spring Framework [http://www.springframework.org/].

XINS generates POJO's for requests and result on the client and server side. The classes and the methods
are public so that they can be called from another package. The generated POJO's try to follow the Java
Beans specification as much as possible.

For example, if you want to use Spring AOP transaction for a specific API, you can define as point cut all
methods starting with call in the generated CAPI class.

On the server side, XINS is a Servlet so you can use it with org.springframework.web.servlet.* [http://
www.springframework.org/docs/api/org/springframework/web/servl et/package-summary.html].

XINS aso includes a Spring framework package. The package is located in
or g. xi ns. conmon. spri ng (javadoc [javadoc/org/xins'common/spring/index.html]). This package
isadding afew convinient classes for validation, factory bean and client interceptor.

Dojo toolkit

The Dojo toolkit [http://dojotoolkit.org/] has several waysto communicate with the server.

One of it is JISON-RPC (dojo.rpc.JsonService) which is also supported by XINS on the server side with
the Xxi ns-j sonr pc caling convention. The easiest way to use this JsonService is in combinaison
with a SMD (Simple Method Description). SMD is a file which describes the name of the methods of
the APl with the expected parameters. There are two ways to get this file from XINS. Either execute the
xins smd command that will generate the file bui | d\ snd\ <api nane>. snd or by caling the meta
function _SMDto the API you want to invoke. An exampleis provided indeno\ capi s\ j avascri pt

\ cal | M\yFuncti onDoj o. ht m .

You can aso use dojo.rpc.YahooService where calls will be received by the xi ns-j son calling
convention. This serviceisalso able to read and interpret the SMD file.

Google Web Toolkit (GWT)

AJAX

GWT [http://code.google.com/webtoolkit/] has mostly two ways to communicate with a
server. They first have their own RPC system [http://code.google.com/webtoolkit/documentation/
com.googl e.gwt.doc.Devel operGuide.RemoteProcedureCalls.html]. GWT also facilitatesthe call to APIs
using the Y ahoo JSON protocol which matchesthe Xi ns-j son calling convention.

An exampleis provided at http://gwt.google.com/samples/JISON/JSON.html.

Note that XINS also supports the callback parameter which is use to indicate to the call which method
should be called with the output parameter when the response returns.

The others (than Dojo and GWT) AJAX frameworks are also supported.
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Mule

They have different waysto call XINS. They can usethe _xins-json or _xins-jsonrpc calling conventions
but also the xins-std and parse the returned XML themselve or use the xins-xdlt calling convention in
combination with an XSLT stylesheet that transform the XML in the HTML to insert dynamiccally in
the page.

Several examples of the later are provided in thedeno\ capi s\ j avascri pt directory.

Mule[http://mule.codehaus.org/display/MUL E/Home] isthe most popular open source Entreprise Service
Bus (ESB).

As XINSisaServlet, you can register ahandler on the URI (embedded Jetty), or bind through an existing
web container (servlet endpoint).

Documentation can be found in the org.mule.providers.http.jetty [http://
mule.codehaus.org/docs/apidocs/org/mul e/providers/http/jetty/package-summary.html] package or in the
org.mule.providers.http.servliet [http://mule.codehaus.org/docs/apidocs/org/mule/providers/http/serviet/
package-summary.html] package.

ESB and JavaEE

Ant

Most of modern ESB support the possibility to plug JavaEE servers to it and as part of the JavaEE
specification there is the possibility to deploy and run Servlet, there shouldn't be any problem to install
XINS APIsin an ESB and/or JavaEE server.

The main problem can only be to indicate where find the runtime properties file, as it is normally done
using the org.xins.server.config system property. If you cannot set this property, you can also include the
runtime property file to usein the WAR fileasVEEB- | NF/ xi ns. properti es.

Orchestration is also an important feature in ESB. It can be done using WS-BPEL as XINS APIs can
communicate using SOAP with the _xi ns- soap calling convention. The API can also give the WSDL
file to indicate the SOAP message format with the _WSDL meta function.

XINS uses Ant to generate the different files. It isalso possible to run the tests or the API with Ant targets.
The easiest way to do it isto use the xins task as described in the the section called “xins task”.

Another possibility isto look at the nbbuild.xml file included with the petstore demo and can be used for
other existing APIsor new APIs. Note that some of the targets are NetBeans specific but most of them not.

Maven

XINS also has support for Maven 2.

Each stable releases are added in the Maven 2 repository (http://www.ibiblio.org/maven/org.xing/). Note
that not only the jar files are included, the source code and the Javadoc are also included.

If you want to build your API using API using Maven, you can execute xins maven command which will
createthe<api nane>. pomintheapi s\ <api nane> directory. Notethat the external dependencies
(other than XINS) are not included in the generated POM and you should add them manually.
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Script languages (Groovy, Ruby, PHP, Perl...)

On the client side it is possible to either call the standard calling convention or use a standard protocol
such as SOAP or XML-RPC.

As the standard calling convention is simple, it should be easy to write a script that creates a URL, send
it and parses the XML response returned.

Some of the script also havelibrariesto call aserver by using SOAP or XML-RPC. XML-RPC clientsare
listed at http://www.xmlrpc.com/directory/1568/implementations.

Examples with different script are provided in the deno\ capi s directory.

You can also implement an API using a script language. In this case you need to use alibrary to pass the
input parameters to the script and get the output parameters from the script. An example is provided in
XINS using Groovy as script language in the deno\ xi ns- pr oj ect \ api s\t ool box directory.
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